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This is a monthly deep audit. The crawler performed a full-site scan including

Lighthouse performance, axe-core accessibility (WCAG 2.2 AA), cross-browser compatibility,

security headers, schema markup validation, and SEO best-practice checks.

Because this site is not a repository we control, Apex Sentinel **cannot automatically

apply fixes** — instead, each finding below includes an AI-generated plain-English

explanation + step-by-step recommended fix you can hand to a developer or execute

in your CMS directly.

Executive Summary

Overall grade: F

DIMENSION COUNT MEANING

Pages crawled 69 Full sitemap + linked pages

P0 (critical) 1 Site-down or compliance-breaking

P1 (urgent) 8 Significant revenue / SEO / UX impact
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DIMENSION COUNT MEANING

P2 (high) 83 Quality / ranking / trust degradation

P3 (medium) 48 Polish + optimization

"Do first" items 8 AI-flagged top priorities

Quick wins (< 30 min) 54 Fastest ROI items

Top 10 Actions (Ranked)

If you only have time for ten things this month, do these — in this order.

1. [P0] 🔴  DO FIRST Sensitive artifact exposed: /wp-login.php — _Exposed login pages increase the risk of

unauthorized account takeover, which could lead to malware injection, data theft, or defacement that

damages your reputation and stops clients from trusting your site._

Page: https://bihnconstruction.com/wp-login.php

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST Age gate not detected — _Missing age gate exposes your business to regulatory fines,

license suspension, or revocation, and creates legal liability if minors access product information._

Page: https://bihnconstruction.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST Lighthouse perf (desktop): 0/100 — _A non-functional or extremely slow homepage

prevents potential clients from viewing your portfolio, learning about your services, or contacting you—

directly losing business and damaging your credibility._

Page: https://bihnconstruction.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST Lighthouse a11y (desktop): 0/100 — _A construction agency relies on trust and

professionalism; inaccessible sites frustrate visitors, reduce time on site, trigger legal liability under

ADA/AODA, and exclude potential clients who use assistive technology (screen readers, voice control)._

Page: https://bihnconstruction.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST Lighthouse bestPractices (desktop): 0/100 — _A score of 0 signals to search engines

and visitors that your site may be unsafe or poorly maintained, directly reducing organic traffic and lead

inquiries from potential construction clients._

Page: https://bihnconstruction.com/

Effort: Moderate (1-3 hours)
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1. [P1] 🔴  DO FIRST Lighthouse seo (desktop): 0/100 — _Construction projects depend on local search

visibility—potential clients searching 'general contractor near me' or 'construction services [city]' won't find

you, directly reducing inbound leads and quotes._

Page: https://bihnconstruction.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST A11y: <html> element must have a lang attribute — _Users relying on screen readers

will have a degraded experience, and your site may not rank well in search results for international or

accessibility-focused queries; WCAG compliance issues can also expose you to legal liability under the

ADA._

Page: https://bihnconstruction.com/

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST Journey failed: default: homepage → age gate → menu visible — _A broken age gate

creates friction at the critical compliance checkpoint; potential customers may bounce rather than retry, and

you lose revenue while also risking non-compliance with cannabis regulations that require age verification._

Page: https://bihnconstruction.com/

Effort: Moderate (1-3 hours)

1. [P1] 🟠  HIGH 2 mixed-content references (http://) — _Visitors may see broken functionality, security

warnings, or decide your site is unsafe — directly harming lead generation and client confidence for a

construction company._

Page: https://bihnconstruction.com/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH 5 image(s) missing alt text — _Missing alt text reduces your blog's SEO value, makes it

inaccessible to people using screen readers (a legal and ethical issue), and loses potential traffic from

Google Images where construction project photos could drive leads._

Page: https://bihnconstruction.com/blog/

Effort: Quick win (< 30 min)

Findings by Severity

P0 — 1 finding

1. Sensitive artifact exposed: /wp-login.php

Severity: P0 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: security

Page URL: https://bihnconstruction.com/wp-login.php

Rule: tier5.exposed.artifact
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What it means (plain English)

Your WordPress admin login page (/wp-login.php) is publicly accessible and returns a success response. This is

a standard WordPress file, but leaving it exposed makes your site an easy target for automated attacks that try

to guess passwords. Attackers can repeatedly attempt logins without friction.

Why it matters for your business: Exposed login pages increase the risk of unauthorized account takeover,

which could lead to malware injection, data theft, or defacement that damages your reputation and stops clients

from trusting your site.

Technical root cause: WordPress login endpoints are publicly accessible by default. Without server-level

protection (IP whitelisting, rate limiting, or IP blocking), the login form remains a direct target for brute-force

attacks.

Recommended fix — step by step

1. Log into your WordPress admin → Settings → General, verify the WordPress Address and Site Address use

HTTPS (not HTTP).

2. Install and activate the Wordfence Security plugin (free tier includes login lockdown): go to Plugins → Add

New → search 'Wordfence' → Install → Activate.

3. Open Wordfence → Login Security → enable 'Enable Login Security' and set 'Force two-factor

authentication' for all admin users.

4. In Wordfence → Tools → Whitelisting, add your office IP address(es) to the whitelist so lockouts don't affect

your team.

5. Alternatively, contact your hosting provider and request they add IP-based access controls to /wp-login.php

(allow only your office IPs, block all others).

6. If your host supports .htaccess (Apache servers), ask them to add: <Files wp-login.php> Deny from all Allow

from YOUR_IP </Files> to your root .htaccess file.

P1 — 8 findings

1. Age gate not detected

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: compliance

Page URL: https://bihnconstruction.com/

Rule: tier1.compliance.age-gate-missing

What it means (plain English)

Your homepage does not display an age verification prompt asking visitors to confirm they are 21 or older

before accessing content. Cannabis retailers are legally required in most jurisdictions to gate access to age-

restricted products and prevent minors from viewing product information or pricing.

Why it matters for your business: Missing age gate exposes your business to regulatory fines, license

suspension, or revocation, and creates legal liability if minors access product information.

Technical root cause: No age-gate modal, overlay, or entry page has been implemented in the WordPress site.

The homepage loads directly without triggering a verification check.

Recommended fix — step by step
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1. Install a WordPress age-gate plugin such as 'Age Gate' (by Tyche Softwares) or 'Age Verification' (by

WebFactory Ltd) from the WordPress.org plugin directory.

2. Navigate to WordPress Admin → Plugins → Add New, search for 'age gate cannabis' or 'age verification',

install, and activate.

3. Configure the plugin to display on the homepage with text 'You must be 21 or older to enter' or equivalent

compliant language.

4. Test the gate by clearing cookies, visiting the homepage in an incognito/private browser window, and

confirming the modal appears before any product or age-restricted content loads.

5. Document your age-gate implementation and compliance method in a policy document; share with your

legal/compliance team for sign-off.

6. If you operate in states with specific age-gate requirements (e.g., California's track-and-trace rules), consult

your state's cannabis board to confirm the plugin meets local standards.

2. Lighthouse perf (desktop): 0/100

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: revenue

Page URL: https://bihnconstruction.com/

Rule: tier8.lighthouse.perf-desktop

What it means (plain English)

Your homepage is scoring 0/100 on Google's Lighthouse performance test, which measures how fast your site

loads and responds to user interactions. This suggests critical issues such as missing stylesheets, broken

JavaScript, or the page failing to load entirely. A score of 0 typically indicates the page either didn't load or

encountered fatal errors during testing.

Why it matters for your business: A non-functional or extremely slow homepage prevents potential clients

from viewing your portfolio, learning about your services, or contacting you—directly losing business and

damaging your credibility.

Technical root cause: The page likely failed to load completely, has render-blocking resources (CSS or

JavaScript) that prevent content display, or contains a critical JavaScript error that breaks the page before it

becomes interactive.

Recommended fix — step by step

1. Log in to WordPress admin → Tools → Site Health and review all Critical and Recommended warnings; fix any

blocking issues (e.g., plugin conflicts, memory limits)

2. Deactivate all plugins temporarily, reload the homepage, and verify it loads and displays correctly

3. Re-enable plugins one at a time and reload the homepage after each to identify which plugin causes the

failure

4. Check the WordPress Theme → Customizer → Additional CSS for any broken or incomplete CSS code;

remove or fix syntax errors

5. Open browser DevTools (F12) on the homepage, check the Console tab for JavaScript errors, and note which

script is failing

6. If errors persist, inspect the <head> section for render-blocking stylesheets or scripts using WordPress →

Settings → Disable inline scripts if available, or contact your hosting provider to review error logs

7. After fixes, run Lighthouse again via PageSpeed Insights (paste your URL at pagespeedinsights.web.dev) to

confirm the score improves above 50
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3. Lighthouse a11y (desktop): 0/100

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: compliance

Page URL: https://bihnconstruction.com/

Rule: tier8.lighthouse.a11y-desktop

What it means (plain English)

Your website is scoring 0/100 on accessibility (a11y), meaning it has critical barriers preventing people with

disabilities from using it. This could include missing alt text on images, broken keyboard navigation, missing

form labels, or insufficient color contrast. The Lighthouse report in your audit folder lists specific issues.

Why it matters for your business: A construction agency relies on trust and professionalism; inaccessible

sites frustrate visitors, reduce time on site, trigger legal liability under ADA/AODA, and exclude potential clients

who use assistive technology (screen readers, voice control).

Technical root cause: WordPress themes and plugins often ship with accessibility violations—missing semantic

HTML, images without alt attributes, forms without labels, or improper heading hierarchy. These aren't always

visible to sighted users but block assistive technology.

Recommended fix — step by step

1. Download and open the Lighthouse HTML report from the audit (/Users/markwallace/BKH/apex-

sentinel/runs/2026-04-19T06-18-18-831Z/lighthouse/bihn-construction/lighthouse-desktop.html) and read

the 'Accessibility' section to see the top 3–5 failures.

2. In WordPress Admin → Pages, check your homepage and main service pages: look for images without alt

text (click image, check 'Alt Text' field) and add concise descriptions (e.g., 'Excavator at residential

foundation site').

3. Go to Admin → Plugins and search 'WP Accessibility' or 'Accessibility Checker'—install and activate one

(free options exist). Run its scan and fix flagged issues (heading hierarchy, contrast, form labels).

4. Test keyboard navigation: open the live site, press Tab repeatedly to navigate links and buttons. If you get

stuck or can't see a focus indicator, that's a problem—note affected elements.

5. Ensure all form fields have visible labels: in form builder (Contact Form 7, WPForms, etc.), confirm every

input has a <label> or aria-label attribute.

6. Check text contrast: use a free tool like WebAIM Contrast Checker on key text vs. background colors. Aim

for at least 4.5:1 ratio for body text.

7. Re-run Lighthouse Desktop after fixes (Admin → SEO → Site Audit in Yoast, or use Google Chrome DevTools

→ Lighthouse) and aim for 80+ before handing to dev.

4. Lighthouse bestPractices (desktop): 0/100

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: security

Page URL: https://bihnconstruction.com/

Rule: tier8.lighthouse.bestPractices-desktop

What it means (plain English)

https://bihnconstruction.com/
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Your site received a Lighthouse Best Practices score of 0/100, meaning it has critical issues affecting browser

compatibility, security, or code quality. This is not a cannabis-specific audit (your site is a construction agency,

not a dispensary), but the zero score indicates fundamental problems that will harm user trust and search

rankings. The full HTML report shows exactly which best-practice violations need fixing.

Why it matters for your business: A score of 0 signals to search engines and visitors that your site may be

unsafe or poorly maintained, directly reducing organic traffic and lead inquiries from potential construction

clients.

Technical root cause: Lighthouse Best Practices failures typically stem from deprecated libraries, missing

security headers, unpatched third-party plugins, mixed HTTP/HTTPS content, or outdated WordPress

core/plugin versions. Without viewing the HTML report, the exact cause cannot be pinned, but WordPress sites

commonly fail due to unmaintained plugins or insecure embeds.

Recommended fix — step by step

1. Download and open the HTML report at /Users/markwallace/BKH/apex-sentinel/runs/2026-04-19T06-18-18-

831Z/lighthouse/bihn-construction/lighthouse-desktop.html — this lists every violation with explanations.

2. In WordPress admin, go to Plugins → Installed Plugins and check for any marked 'inactive' or with red update

badges; update or deactivate outdated plugins immediately.

3. Update WordPress core: Admin → Dashboard → look for WordPress version notice; click 'Update' if

available.

4. Check for mixed content warnings: use a tool like https://www.ssllabs.com/ssltest/ or Chrome DevTools (F12

→ Console) while visiting your homepage; flag any http:// URLs loaded over https://.

5. Review any custom code in Appearance → Theme File Editor or custom theme functions.php for deprecated

functions; if unsure, consult your hosting provider's security guidelines.

6. Install and run Wordfence Security (free plugin): Admin → Plugins → Add New → search 'Wordfence' →

install and activate → run full scan.

7. Re-run Lighthouse after fixes: use Google PageSpeed Insights (https://pagespeed.web.dev/) and paste your

URL to confirm score improves.

5. Lighthouse seo (desktop): 0/100

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://bihnconstruction.com/

Rule: tier8.lighthouse.seo-desktop

What it means (plain English)

Your homepage is receiving a zero SEO score from Lighthouse, which means search engines (Google, Bing)

cannot properly understand or index your site's content. This typically indicates missing critical SEO metadata

like page titles, meta descriptions, heading structure, or schema markup that tells search engines what your

business does.

Why it matters for your business: Construction projects depend on local search visibility—potential clients

searching 'general contractor near me' or 'construction services [city]' won't find you, directly reducing

inbound leads and quotes.

Technical root cause: WordPress sites often ship with SEO plugins disabled or misconfigured, or the

homepage template lacks proper HTML structure (missing H1 tag, broken title tags, or no Open Graph tags).

https://www.ssllabs.com/ssltest/
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The Lighthouse report shows zero performance, accessibility, and best practices scores too, suggesting the

site may not be loading properly or has fundamental HTML issues.

Recommended fix — step by step

1. Install and activate Yoast SEO or Rank Math (free versions) from WordPress Plugins → Add New. Search

'Yoast SEO', click Install, then Activate.

2. Open the Yoast setup wizard (you'll see a prompt in wp-admin) and complete the business name, location,

and service type fields.

3. Edit your homepage: Dashboard → Pages → Home. Check that the page has a clear H1 heading (not just the

site title). If missing, add one: 'Construction & Building Services by Bihn Construction' or similar.

4. In the Yoast SEO box at the bottom of the page editor, set a focus keyword (e.g., 'construction contractor

[your city]'), write a meta description (~160 characters), and ensure the plugin shows green lights.

5. Add schema markup for your business: use Yoast's Schema section (Local Business tab) to input your

address, phone, license number, and service areas.

6. Re-run Lighthouse in Chrome DevTools (right-click → Inspect → Lighthouse tab → Generate report) and

verify SEO score rises above 90.

7. If the site is still at zero after Yoast activation, check that WordPress Permalinks are set to 'Post name'

(Settings → Permalinks) and save.

6. A11y: <html> element must have a lang attribute

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/

Rule: tier9.a11y.html-has-lang

What it means (plain English)

Your website's main HTML page is missing a lang  attribute on the <html>  tag. This attribute tells screen

readers and search engines what language your content is in. Without it, assistive technologies may default to

the wrong language or fail to read your site aloud correctly.

Why it matters for your business: Users relying on screen readers will have a degraded experience, and your

site may not rank well in search results for international or accessibility-focused queries; WCAG compliance

issues can also expose you to legal liability under the ADA.

Technical root cause: The root <html> tag in your WordPress theme's header template (typically header.php or

an HTML5 theme template) does not include the lang attribute, likely because the theme was never configured

or updated to meet accessibility standards.

Recommended fix — step by step

1. Log in to WordPress admin > Appearance > Theme File Editor

2. Open header.php (or the file containing the opening <html> tag—often labeled 'Template Files' in the editor

sidebar)

3. Find the line <html>  and change it to <html lang="en">  (use your site's primary language code;

'en' for English)

4. Click Update File

5. Run a full-page audit on https://bihnconstruction.com/ using axe DevTools (free browser extension) to

confirm the fix

https://bihnconstruction.com/
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6. If you cannot locate header.php or your theme uses block templates, navigate to Appearance > Customize >

Site Identity and check if there is a Language setting—if not, contact your theme vendor or a WordPress-

certified developer to add lang attribute support

7. Journey failed: default: homepage → age gate → menu visible

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: compliance

Page URL: https://bihnconstruction.com/

Rule: tier10.journey.failed

What it means (plain English)

Your website is throwing a 403 error (access denied) when loading a resource during the age-gate flow. This

means something on the page—likely a script, stylesheet, or image—is being blocked by your server or a

security plugin. Visitors may see broken functionality or partial page loads when they try to verify their age and

access the menu.

Why it matters for your business: A broken age gate creates friction at the critical compliance checkpoint;

potential customers may bounce rather than retry, and you lose revenue while also risking non-compliance with

cannabis regulations that require age verification.

Technical root cause: A resource (JavaScript, CSS, font, or image) required for the age-gate interaction is

returning HTTP 403. This is typically caused by a WordPress security plugin (like Wordfence or iThemes

Security) blocking the request, or the resource path is misconfigured in your age-gate plugin.

Recommended fix — step by step

1. Open WordPress admin → Plugins; identify any security plugins (Wordfence, iThemes Security, Sucuri, etc.)

and temporarily deactivate each one, then test the age gate flow in a private/incognito browser window to

isolate which plugin is the culprit.

2. If a security plugin is blocking, go to that plugin's settings (e.g., Wordfence → Firewall → Blocked

Resources) and check the log for the 403-blocked resource URL; whitelist that URL or URL pattern.

3. Check your age-gate plugin settings (e.g., in Dashboard → Plugins settings or the plugin's own admin panel)

and verify all resource paths (script/stylesheet URLs) are correct and not pointing to a restricted folder.

4. If using a custom age gate or third-party service, ensure its domain is not blocked by your firewall rules

(Admin → All-in-One WP Security & Firewall → IP Whitelist, or equivalent in your security plugin).

5. Clear your WordPress cache (if using WP Super Cache, W3 Total Cache, or similar) via Admin → Tools or the

plugin dashboard.

6. Open Chrome DevTools (F12) → Network tab, reload the page, and identify which resource returns 403; note

its full URL and file type, then report to your hosting support if the issue persists after steps 1–5.

8. 2 mixed-content references (http://)

Severity: P1 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: security

Page URL: https://bihnconstruction.com/

Rule: tier5.mixed-content
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What it means (plain English)

Your site is served over HTTPS (secure), but it's linking to two resources via HTTP (insecure). Browsers will

either block these resources or show security warnings to visitors, which erodes trust and can prevent scripts

or styles from loading correctly.

Why it matters for your business: Visitors may see broken functionality, security warnings, or decide your site

is unsafe — directly harming lead generation and client confidence for a construction company.

Technical root cause: The schema.org reference is a false positive (the spec intentionally uses http:// URIs),

but the undefined resource indicates a malformed or missing protocol in a script/stylesheet tag, likely added via

a plugin or theme setting.

Recommended fix — step by step

1. Log in to WordPress admin → Inspect → Elements and search for 'http://' to identify all insecure references

on the homepage.

2. The schema.org reference is spec-compliant; no action needed there. Focus on the 'undefined' resource.

3. Check WordPress admin → Settings → General and ensure both Site URL and WordPress URL use https://.

4. Go to Plugins → Installed Plugins and review any recently activated plugin that might inject scripts (e.g.,

analytics, tracking, or third-party widgets); check its settings for http:// URLs.

5. If using a page builder (Elementor, Divi, etc.), open the affected page and search each element's settings for

hardcoded http:// URLs; switch to https:// or protocol-relative URLs (//example.com).

6. Use WordPress admin → Appearance → Customize and check each custom CSS or header/footer code for

http:// links; update to https://.

7. Run a full-site scan using a tool like Screaming Frog SEO Spider (filter by Protocol) to catch any remaining

http:// references site-wide.

8. After fixes, clear WordPress cache (if using a caching plugin like WP Super Cache) and re-test in a fresh

incognito browser window.

P2 — 83 findings

1. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/blog/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your blog page has 5 images without alt text—short descriptions that screen readers use to tell visually

impaired visitors what an image shows. These missing descriptions also prevent search engines from

understanding your images, which can impact how your blog content ranks and appears in image search results.

Why it matters for your business: Missing alt text reduces your blog's SEO value, makes it inaccessible to

people using screen readers (a legal and ethical issue), and loses potential traffic from Google Images where

construction project photos could drive leads.

http://'/
https://./
https://./
https://bihnconstruction.com/blog/


Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the media

library or image block settings, or alt text was left blank during initial post creation.

Recommended fix — step by step

1. Log into WordPress Admin → navigate to the blog post at /blog/

2. Edit the post → scan each image block or embedded image for alt text

3. For each of the 5 images without alt: click the image → in the right sidebar, find 'Alt Text' field and write a 5–

15 word description (e.g., 'Concrete foundation pour on residential project in downtown area')

4. After adding alt text, click Publish or Update

5. Run a quick recheck using a free tool like WAVE (wave.webaim.org) to verify all 15 images now have alt text

2. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://bihnconstruction.com/home-renovation-contractors/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your home renovation contractors page lack alt text — descriptive labels that tell search engines

and screen readers what the image shows. This hurts both accessibility (people using screen readers can't

understand those images) and SEO (search engines can't index the images, so you miss ranking opportunities

for image search and lose context signals for the page).

Why it matters for your business: Missing alt text reduces your visibility in Google Images, lowers page SEO

authority, and makes your site harder to use for visitors with visual impairments — a legal and reputational risk.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the media

library, or were embedded via code without an alt attribute.

Recommended fix — step by step

1. Log into WordPress admin → Media Library → filter by 'Unattached' or search for images used on the home-

renovation-contractors page

2. For each image, click Edit → scroll to Alt Text field → write a 5–12 word description (e.g., 'Kitchen remodel

with granite counters and white cabinets' instead of 'image1')

3. If images are embedded via a page builder (Elementor, Gutenberg, etc.), open the page editor → click each

image block → fill the Alt Text field in the sidebar

4. Test: visit https://bihnconstruction.com/home-renovation-contractors/ in a screen reader (free: NVDA on

Windows) or use a Chrome extension like 'axe DevTools' to confirm alt text is now present

5. Repeat for any other pages with images (portfolio, gallery, service pages)

3. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/bathroom-renovation-cost/
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Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your bathroom renovation cost page are missing alt text — descriptive labels that screen readers

use to describe images to visually impaired users, and that search engines use to understand image content.

This creates a poor experience for users with disabilities and signals to Google that your content is incomplete.

Why it matters for your business: Missing alt text reduces your search visibility for image-based queries (e.g.,

'bathroom renovation before/after') and excludes disabled visitors, shrinking your addressable market and

exposing you to ADA compliance risk.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the media

library, or the theme's image template is not pulling alt attributes from post content.

Recommended fix — step by step

1. Log into WordPress admin → Media Library → search for images used on /bathroom-renovation-cost/ → click

each image → fill Alt Text field with descriptive text (e.g., 'Modern white subway tile bathroom before

renovation' for before/after pairs)

2. If images are embedded via shortcode or Gutenberg blocks, edit the post → click each image block → open

the Advanced panel (right sidebar) → add Alt text

3. For each image, write alt text that describes what users see AND why it matters (e.g., 'Marble countertop

installation in luxury master bathroom' rather than 'bathroom3.jpg')

4. Install the Yoast SEO plugin (free version) → go to the bathroom renovation post → it will flag images with

missing alt in the content analysis sidebar

5. After fixing, use Google Search Console (Google → Search Console → your property → Pages without title

tags) to reindex the page by clicking 'Request Indexing'

4. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/contractor-for-kitchen-remodel/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your kitchen remodel page has 5 images without alt text — descriptive labels that screen readers use to tell

blind visitors what an image shows, and that search engines use to understand your content. This hurts both

accessibility (people using assistive technology can't see what those images depict) and SEO (Google can't

index the content of those images).

Why it matters for your business: Missing alt text reduces your organic search ranking for image-based

queries, limits visibility to users with visual impairments (a legal risk under ADA), and wastes the SEO value of

your photography.

Technical root cause: Images were inserted into the WordPress page without the alt text field being filled in.

This is typically a content entry oversight during page creation or editing.

Recommended fix — step by step

1. Log in to WordPress admin → Pages → find and open 'Contractor for Kitchen Remodel'

2. In the page editor, click each image to select it
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3. In the right sidebar (Image Block settings), locate the 'Alt text' field

4. Write descriptive alt text for each image (e.g., 'Custom kitchen with granite counters and stainless steel

appliances' rather than 'image1')

5. Ensure each alt description is 1–2 sentences and includes relevant keywords naturally (e.g., 'kitchen

remodel' if appropriate)

6. Click Update to save changes

7. Run the page through axe DevTools (free browser extension) to verify all images now have alt text

5. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/small-kitchen-remodel-cost/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your kitchen remodel cost page don't have alt text—descriptive labels that screen readers

announce to visitors with vision disabilities, and that search engines use to understand what images show. This

means those images are invisible to both assistive technology users and search bots, limiting both accessibility

and SEO benefit.

Why it matters for your business: Missing alt text reduces your ability to rank for image search queries (e.g.,

'kitchen remodel before/after'), excludes customers using screen readers or with images disabled, and signals

to Google that your content quality is incomplete.

Technical root cause: Images were likely added to the page without filling in the alt text field in WordPress's

image uploader, or existing images were not retrofitted with descriptive text when the page was published.

Recommended fix — step by step

1. Log into WordPress → navigate to Pages → Kitchen Remodel Cost page → click Edit

2. Scroll through the page and click each of the 5 images without alt text (or use Inspector/browser dev tools

to identify them by hovering)

3. For each image, click it to open the editing sidebar, locate the Alt Text field, and write a 5–12 word

description (e.g., 'Small galley kitchen with white cabinets and granite countertops before renovation')

4. Ensure each alt text describes what's visible and relevant to the page topic—avoid keyword stuffing or

'image' or 'photo'

5. Publish/Update the page and use a free tool like WAVE (wave.webaim.org) to re-scan and confirm all images

now have alt text

6. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/new-construction-home-inspection/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)
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Five images on your new construction inspection page don't have alt text—a written description that screen

readers use to tell visually impaired visitors what the image shows, and that search engines use to understand

your content. This affects both accessibility (people using screen readers get no context) and SEO (Google

can't index what the image depicts).

Why it matters for your business: Missing alt text reduces your page's search ranking potential for

construction-related queries and makes your site unusable for visitors relying on screen readers, limiting your

audience and creating potential legal liability under accessibility laws.

Technical root cause: Images were inserted into the WordPress page without filling in the Alt Text field during

upload or edit. WordPress allows images to be published without alt attributes, defaulting to empty.

Recommended fix — step by step

1. Log into WordPress admin → Pages → New Construction Home Inspection (or search by title)

2. In the page editor, locate each of the 5 images missing alt text (hover over images or use the block/image

inspector panel)

3. Click each image → in the right sidebar, find the 'Alt Text' field (usually under Image Settings or Advanced)

4. Write a short, descriptive alt text for each (e.g., 'structural inspection of foundation crack,' 'home inspector

measuring window frame,' 'electrical panel during safety audit'—be specific to what's shown)

5. Save/update the page and publish

6. After publishing, run the page through a free accessibility checker like WAVE (wave.webaim.org) to confirm

all 20 images now have alt text

7. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/split-level-kitchen-remodel/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your website has 5 images on the kitchen remodel page that lack alt text — a text description of what each

image shows. Search engines can't read images directly; they rely on alt text to understand what's pictured.

Without it, you lose SEO signals and visitors using screen readers (including some of your potential clients) get

no context for those images.

Why it matters for your business: Missing alt text reduces your kitchen remodel page's ranking potential for

image search and local SEO, and excludes users with visual impairments — both shrink your addressable

market.

Technical root cause: Images were likely uploaded to WordPress without filling in the alt text field in the media

uploader, or the image blocks/plugins on that page weren't configured with alt attributes when created.

Recommended fix — step by step

1. Log into WordPress admin → go to Media Library → filter by images used on the split-level kitchen remodel

page (or navigate directly to that page in edit mode).

2. Click each image and check the 'Alt Text' field in the right sidebar; if blank, write a descriptive phrase (e.g.,

'White subway tile backsplash with stainless steel fixtures' or 'Before: original 1980s kitchen cabinets').

3. Ensure each alt text is 8–15 words, describes what's visible, and includes relevant keywords naturally (e.g.,

kitchen style, materials, design feature) without keyword stuffing.
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4. Save each image and republish the page.

5. Run a quick audit using the WAVE browser extension (wave.webaim.org) on that same page to confirm the

errors are gone.

8. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/flooring-contractor-insights/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your flooring contractor insights page don't have alt text—the hidden descriptions search

engines and screen readers use to understand images. This means visitors using screen readers can't know

what those images show, and search engines can't index them for image search or use them to understand your

page topic.

Why it matters for your business: Missing alt text reduces your visibility in Google Image Search (a source of

referral traffic for contractors) and makes your site less accessible to users with visual disabilities, which is both

a legal compliance issue and excludes potential customers.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the media

library, or the image blocks were inserted without alt attributes defined.

Recommended fix — step by step

1. Log into WordPress admin → Go to Media Library → Search for images used on the flooring-contractor-

insights post

2. For each of the 5 images, click the image → Scroll to Alt Text field → Write descriptive alt text (e.g.,

'Engineered hardwood flooring installation in progress' not just 'flooring')

3. Alternatively, edit the flooring-contractor-insights post directly → Click each image block → Right panel →

Image settings → Alt Text field → Add description

4. Ensure alt text describes what the image shows and relates to your flooring services (use keywords

naturally: 'custom tile backsplash installation' vs generic 'image1')

5. Save changes and publish

6. Run the page through WebAIM's WAVE tool (wave.webaim.org) to verify all images now have alt text

9. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/pool-contractors/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your pool contractors page don't have alt text—descriptive labels that explain what each image

shows. Search engines and assistive technology (used by people with vision impairments) can't understand

unlabeled images, so they miss important content about your work and services.
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Why it matters for your business: Missing alt text costs you SEO ranking for image search and reduces

accessibility, limiting organic traffic from potential clients searching for pool construction photos and excluding

users relying on screen readers.

Technical root cause: Images were uploaded to WordPress without filling the Alt Text field in the media library

or image block. WordPress doesn't auto-generate these labels, so they default to empty.

Recommended fix — step by step

1. Go to WordPress admin → Pages → Pool Contractors → Edit with Gutenberg editor

2. Identify each image block (look for image icons with red/orange warnings in the editor)

3. Click each image → in the right sidebar under 'Alt text' field, write a short description (e.g., 'Custom

concrete pool with waterfall feature' or 'Before and after pool renovation')

4. Use descriptive, natural language that mentions the pool type or improvement—avoid keyword stuffing

5. Publish and test: use a free tool like WAVE (wave.webaim.org) to confirm alt text appears

10. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/basement-renovation-cost/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your basement renovation cost page don't have alt text—descriptive labels that explain what

each image shows. Search engines and screen readers (used by people with vision impairments) can't

understand these images without that text. This limits your SEO and makes your site less accessible to potential

customers.

Why it matters for your business: Missing alt text reduces your page's ranking for image-related searches and

excludes users relying on screen readers, shrinking your potential customer base and risking ADA compliance

concerns.

Technical root cause: Images were likely uploaded to WordPress without filling in the Alt Text field during the

upload process, or the image blocks in the page editor weren't configured with alt attributes.

Recommended fix — step by step

1. Log into WordPress admin → Pages → Edit 'Basement Renovation Cost' page

2. For each image block, click the image → in the right panel under 'Alt Text', enter a clear 1–8 word description

(e.g., 'Finished basement with new flooring and lighting' or 'Before-and-after basement waterproofing')

3. Ensure descriptions reflect what's actually visible and relevant to basement renovation (e.g., include

material types, rooms, or renovation stages when applicable)

4. Click Update to save changes

5. Install Yoast SEO plugin (if not already active) → SEO → Title & Metas, scroll to 'Images' section to verify all

images now show green checkmarks

6. Test in a screen reader: use NVDA (free, Windows) or Safari with VoiceOver (Mac) to navigate the page and

confirm alt text reads aloud

11. 5 image(s) missing alt text
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Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/whole-home-remodel/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your whole-home remodel page lack alt text — short descriptive text that screen readers read

aloud to visually impaired visitors, and that search engines use to understand image content. This makes those

images invisible to assistive technology and search engines, reducing accessibility and missing SEO

opportunity.

Why it matters for your business: Visually impaired prospects can't understand key project photos, and

Google can't index those images in image search or use them to rank the page for relevant keywords like 'whole

home remodel Portland' — costing you qualified traffic.

Technical root cause: Images were likely uploaded to WordPress media library and inserted into the page

without filling in the Alt Text field during upload or in the image block settings.

Recommended fix — step by step

1. Log into WordPress Admin → Pages → Whole Home Remodel → Edit with Gutenberg block editor

2. Identify each image block (there should be 5 missing alt text)

3. Click each image block and look for the Alt Text field in the right sidebar Inspector panel

4. Write 1–2 sentence descriptions for each: e.g., 'Before photo of kitchen with dated cabinets and tile' or

'After photo of renovated master bathroom with walk-in shower'

5. Save the page and regenerate cache if using a caching plugin like WP Super Cache

12. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/excavation-contractors/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your excavation contractors page lack alt text — descriptive text that appears if an image fails to

load and is read aloud by screen readers used by people with vision loss. Search engines also use alt text to

understand what images show, which affects how your pages rank.

Why it matters for your business: Missing alt text reduces your page's SEO strength for image searches

(potential lead source) and excludes visitors using assistive technology, shrinking your addressable audience.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the media

attachment settings, or were embedded via HTML/code without alt attributes.

Recommended fix — step by step

1. Log in to WordPress Admin → Posts/Pages → Edit the Excavation Contractors page

2. In the editor, click each image to open its settings panel
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3. Fill the Alt Text field with a concise, descriptive phrase (e.g., 'Excavator digging foundation trench at

residential site' instead of 'image123')

4. For images that are purely decorative, check the 'Mark as decorative' option instead of leaving alt blank

5. Save and republish the page

6. Repeat for the remaining 4 images (the audit shows 5 of 15 total images affected)

13. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/outdoor-home-renovations/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your outdoor renovations page lack alt text—descriptive labels that tell search engines and

people using screen readers what's in those images. Without alt text, those images are invisible to search

engines and inaccessible to visitors who rely on screen readers.

Why it matters for your business: Missing alt text reduces your page's SEO ranking for renovation-related

searches and excludes potential customers with visual disabilities from understanding your portfolio work.

Technical root cause: Images were likely uploaded to WordPress without filling in the alt text field in the media

uploader, or the image blocks/galleries don't have alt attributes assigned.

Recommended fix — step by step

1. Log in to WordPress admin → go to Media Library → filter by 'Attached to outdoor-home-renovations'

2. For each image missing alt text, click the image → open Details panel (right sidebar) → scroll to 'Alt Text'

field

3. Write 5–10 word descriptions for each (e.g., 'modern deck with composite railings and integrated lighting'

instead of just 'deck')

4. Save each image update

5. Navigate to the /outdoor-home-renovations/ page → inspect each image block/gallery → ensure alt text

displays in block settings

6. Use a browser accessibility checker like WAVE (wave.webaim.org) to verify all 15 images now have alt text

14. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/fireplace-renovation/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your fireplace renovation page lack alt text—a short description that appears if an image fails to

load and helps screen readers describe images to visually impaired visitors. This hurts both accessibility

(legal/ethical concern) and SEO, since search engines use alt text to understand what your images show.
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Why it matters for your business: Missing alt text reduces your chances of appearing in Google Images

search results for renovation work, and exposes you to accessibility compliance complaints; both cost you

qualified leads.

Technical root cause: Images were likely uploaded to WordPress without filling the alt text field in the media

library, or alt text was removed during a theme or page builder update.

Recommended fix — step by step

1. Log in to WordPress admin → go to Media Library → filter by 'Unattached' or search the fireplace-renovation

page URL

2. Identify the 5 images on https://bihnconstruction.com/fireplace-renovation/ that lack alt text (use a free tool

like WAVE browser extension to highlight them)

3. For each image, click it in the Media Library → scroll to 'Alt Text' field → write a descriptive 5–10 word

phrase (e.g., 'Custom stone fireplace surround with built-in shelving' instead of 'fireplace')

4. If images are embedded via a page builder (Elementor, Divi, etc.), click the image block → find Alt Text field

in the sidebar → fill in the same way

5. Save changes and re-test the page with WAVE extension to confirm alt text appears

15. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/luxury-home-construction/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your luxury home construction page has 5 images without alt text — descriptions that tell screen readers and

search engines what the images show. This blocks visually impaired users from understanding your portfolio,

and it wastes an opportunity to reinforce keywords like 'luxury home construction' and specific project details in

search results.

Why it matters for your business: Missing alt text reduces your ability to rank for image searches (a

significant traffic driver for construction portfolios) and limits your site's usefulness to users with visual

impairments, shrinking your addressable audience.

Technical root cause: Images were likely uploaded to WordPress without filling in the 'Alt Text' field in the

media library, or alt attributes were stripped during a page migration or editor change.

Recommended fix — step by step

1. Log into WordPress admin → go to Media Library → filter by images used on /luxury-home-construction/

2. For each of the 5 images without alt text, click the image → scroll to 'Alt Text' field → write a 5–10 word

description (e.g., 'Modern glass and stone luxury home exterior with pool' or 'Master bedroom with floor-to-

ceiling windows overlooking valley')

3. Prioritize images that show your unique design or signature finishes; include material/style keywords

naturally

4. Save each image, then visit the /luxury-home-construction/ page frontend to verify images still load

5. Use Google Search Console (Search → Appearance → Images) to check if your improved images now appear

in Google Images results after re-crawl (2–4 weeks)
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16. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/design-build-contractors/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your Design-Build Contractors page don't have alt text — short descriptions that explain what

each image shows. Search engines and assistive technology (screen readers used by people with vision

disabilities) can't understand image content without it. This means you're missing SEO signals and excluding

potential customers who rely on accessibility tools.

Why it matters for your business: Missing alt text reduces your page's ranking potential for image search and

loses customers with disabilities; it also creates legal liability under accessibility standards like WCAG 2.1.

Technical root cause: Images were uploaded to WordPress without filling the 'Alt Text' field during upload or

when editing the page. WordPress defaults to empty alt attributes if this field is skipped.

Recommended fix — step by step

1. Log in to WordPress admin → navigate to the affected page (Design-Build Contractors) and click Edit

2. In the page editor, find each image block and click the image to select it

3. In the right sidebar under Image settings, locate the 'Alt Text' field and write a short, descriptive phrase

(e.g., 'Modern residential design-build home exterior' or 'Team reviewing construction blueprints')

4. Repeat for all 5 images; aim for 8–12 words per alt text that describes what's visible and its relevance to

construction

5. Click Update to save changes

6. Use a browser accessibility checker (free: WAVE by WebAIM or Axe DevTools) to verify alt text is now

present on the page

17. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/high-end-renovation/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your renovation showcase page lack alt text—descriptive labels that screen readers read aloud

to blind visitors, and that search engines use to understand image content. This means some of your audience

cannot access those images, and Google cannot properly index them for image search or page relevance.

Why it matters for your business: Missing alt text reduces accessibility for potential clients using screen

readers, lowers your page's ranking for renovation-related image searches, and creates compliance risk under

ADA guidelines.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the media

attachment settings, or the images were inserted via HTML without an alt attribute.
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Recommended fix — step by step

1. In WordPress admin, go to Media → Library and search for images used on the /high-end-renovation/ page.

2. Click each image and scroll to the 'Alt Text' field in the right sidebar.

3. Write descriptive alt text for each (e.g., 'Modern kitchen with white cabinetry and granite countertops'

instead of 'IMG_1234').

4. If images are embedded in the page content directly, edit the page, click each image, and fill the Alt Text box

in the image properties dialog.

5. Save and republish the page.

6. Use a free browser tool like WAVE (wave.webaim.org) to re-scan the page and confirm all 5 images now have

alt text.

18. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/major-home-remodel/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your major home remodel page lack alt text — a short description that tells search engines and

screen readers what the image shows. This hurts both accessibility (people using screen readers can't

understand the images) and search visibility (Google can't index image content without these descriptions).

Why it matters for your business: Missing alt text reduces your ability to rank for image search and limits your

site's audience to sighted visitors, while also creating potential legal exposure under accessibility standards.

Technical root cause: Images were uploaded to WordPress without filling in the alt text field in the media

library, or were inserted into the page without the alt attribute being populated.

Recommended fix — step by step

1. Log in to WordPress admin → go to Media → review each image on the major home remodel page and click

to edit; fill in the Alt Text field with a brief, descriptive phrase (e.g., 'Kitchen island with granite countertop

during renovation').

2. Alternatively, navigate to the major home remodel post → click Edit → locate each image in the editor → click

the image → look for Alt Text field in the right sidebar and add descriptions.

3. Use descriptive language that includes the project type and key details (e.g., 'Master bathroom with new tile

flooring and walk-in shower' rather than just 'bathroom').

4. After adding alt text to all five images, click Update/Publish on the post.

5. Run the page through a free accessibility checker (e.g., WAVE.webaim.org or axe DevTools browser

extension) to confirm all images now have alt text.

19. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/the-essential-builders-guide-for-new-lot-owners/
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Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your blog post about lot owners are missing alt text — a brief description that appears if the

image doesn't load and that search engines use to understand what the image shows. This hurts both

accessibility for users with screen readers and your search rankings, since Google can't index the image

content.

Why it matters for your business: Incomplete alt text reduces your chances of ranking for image-based

searches (e.g., 'construction site photos') and excludes visitors using assistive technology, shrinking your

potential audience.

Technical root cause: Images were likely uploaded to WordPress without filling in the alt text field in the media

editor, or the alt field was left blank during initial page creation.

Recommended fix — step by step

1. Log into WordPress admin → Pages → Edit 'The Essential Builders Guide for New Lot Owners'

2. For each image in the post, click it to select it, then click the 'Edit' pencil icon that appears

3. In the image details panel on the right, locate the 'Alt Text' field and write a 5–10 word description of what

the image shows (e.g., 'Surveyor measuring unmarked residential lot with transit equipment')

4. Repeat for all 5 images, then click 'Update' to save the page

5. Optional: Install Yoast SEO (free version) → go to Posts → run the focus keyphrase analysis; Yoast will flag

missing alt text in its checklist as a reminder for future posts

20. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/custom-home-construction-at-lake-keowee-build-your-dream-

lake-house/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your Lake Keowee custom home page lack alt text—descriptive labels that tell search engines

and screen readers what each image shows. Without alt text, people using screen readers can't understand

those images, and search engines can't index them for image search or use them as ranking signals.

Why it matters for your business: Missing alt text reduces your visibility in Google Images (a source of

qualified leads for construction portfolios) and excludes potential clients using assistive technology, shrinking

your addressable market.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the media

uploader, or the image blocks were inserted without the alt attribute being populated.

Recommended fix — step by step

1. Log in to WordPress admin → go to Media Library → filter by the Lake Keowee post

2. For each of the 5 images, click to open its details panel and check the 'Alt Text' field at the bottom right

3. Write descriptive alt text for each: e.g., 'Custom-built stone and timber lake house exterior overlooking Lake

Keowee' (be specific, 10–15 words)
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4. Alternatively, navigate to Posts → Custom Home Construction at Lake Keowee → Edit → scroll to each image

block → click the image → open the block settings panel (right sidebar) → fill 'Alt text' field

5. Save and publish; re-run accessibility audit to confirm all 15 images now have alt text

21. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/the-cliffs-custom-home-construction/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your project gallery page has 5 images without descriptive alt text. Alt text is hidden text that describes what an

image shows — it helps people using screen readers understand your photos, and it tells search engines what

your images are about. This hurts both accessibility (visitors with visual impairments can't use your site) and

SEO (Google can't rank those images or understand the page context as well).

Why it matters for your business: Missing alt text makes your beautiful custom home photos invisible to

search engines and inaccessible to potential clients using assistive technology; you're also at legal risk under

accessibility compliance standards that construction/contractor sites are increasingly audited against.

Technical root cause: Images were added to the page without filling in the 'Alt Text' field in WordPress's media

library or image block settings. When alt fields are left blank, search engines and screen readers see nothing.

Recommended fix — step by step

1. Log into WordPress admin → navigate to the affected page (The Cliffs Custom Home Construction)

2. Click 'Edit' to enter the block editor

3. Find each image block; in the right sidebar under 'Block' settings, locate the 'Alt text' field

4. For each of the 5 images, write a concise 8–12 word description (e.g., 'Modern kitchen with quartz

countertops and stainless steel appliances in custom home' instead of just 'kitchen')

5. Focus on what's visually relevant to your construction/design work; avoid keyword stuffing

6. Click 'Update' to save the page

7. Run a quick check: use a free tool like WAVE (wave.webaim.org) and paste your page URL to confirm all

images now have alt text

22. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/home-builder-greenville-sc/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your Greenville home builder page don't have alt text—a short description that screen readers

read aloud and search engines use to understand the image. This means visually impaired visitors can't tell

https://bihnconstruction.com/the-cliffs-custom-home-construction/
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what those images show, and Google can't index them for image search or use them to understand your page

content.

Why it matters for your business: Missing alt text reduces your visibility in Google Images (a traffic source for

construction portfolios), limits access for potential clients using assistive technology, and signals to search

engines that your content is incomplete.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field during upload or

page editing. WordPress stores alt text in the img tag's alt attribute, and when it's empty, the image is invisible

to both accessibility tools and search engines.

Recommended fix — step by step

1. Log into WordPress → Pages → Home Builder Greenville SC

2. Click Edit to open the page editor

3. Identify each of the 5 images missing alt text (use browser DevTools Inspector if needed, or ask your

developer which ones)

4. Click each image → in the right sidebar Image panel, fill the 'Alt Text' field with a brief description (e.g.,

'Modern kitchen renovation in Greenville with granite countertops and stainless steel appliances')

5. Write alt text that describes the image's content and why it matters; 5–15 words is typical

6. Repeat for all 5 images, then click Update to save the page

7. Visit the page in a browser and right-click each image → Inspect → confirm the alt attribute is now populated

23. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/modern-custom-homes-upstate-sc-innovative-elegant-designs/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your Modern Custom Homes page lack alt text — short text descriptions that screen readers

(used by visually impaired visitors) read aloud, and that search engines use to understand what images show.

This means some visitors cannot access your image content, and Google cannot fully index your portfolio work.

Why it matters for your business: Losing alt text on portfolio images hurts both accessibility compliance

(exposing you to potential ADA claims) and SEO ranking for design-related searches where image indexing

matters.

Technical root cause: Images were likely uploaded to WordPress without alt text filled in the Media Library, or

the theme template does not enforce alt text on image blocks.

Recommended fix — step by step

1. Log into WordPress → go to Media Library and filter by the affected post/page

2. For each of the 5 images, click Edit and fill the Alt Text field with a brief description (e.g., 'Modern two-story

custom home with stone exterior and landscaping')

3. Alternatively, open the post editor, click each image block, and fill Alt Text in the right sidebar under Image

Settings

4. Save the post and verify by using a browser DevTools Inspector (F12 → Elements tab) to confirm each img

tag now has an alt= attribute

https://bihnconstruction.com/modern-custom-homes-upstate-sc-innovative-elegant-designs/


5. Install the free WordPress plugin Accessibility Checker (WP Accessibility) to auto-flag future images missing

alt text

24. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/kitchen-renovation-greenville-sc-what-local-experts-wont-tell-

you-about-costs/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your kitchen renovation article page lack alt text—descriptive labels that help both visually

impaired visitors and search engines understand what's in each image. Alt text is a basic accessibility

requirement and a confirmed Google ranking factor. When images have no alt text, search engines can't index

them, and visitors using screen readers get no context.

Why it matters for your business: Missing alt text reduces SEO value of your content, potentially costing

visibility for high-intent renovation keywords like 'kitchen renovation Greenville SC,' and excludes users with

visual impairments from understanding your portfolio—both shrink qualified leads.

Technical root cause: Images in WordPress were uploaded and inserted without alt text filled in during the

media upload or post editor step. WordPress does not auto-generate alt text, so if it isn't manually added,

images remain unlabeled.

Recommended fix — step by step

1. Open WordPress admin → Posts → edit the 'Kitchen Renovation Greenville SC' post

2. In the editor, click each image (5 missing alt text) to open the image block settings

3. In the 'Alt text' field, write a concise, descriptive label—e.g., 'White subway tile kitchen with granite

countertop and stainless appliances' (include relevant keywords naturally)

4. Repeat for all 5 images and save the post

5. Install the free 'Alt Text' or 'SEOPress' plugin to add a bulk alt text checker so you catch this on future posts

before publishing

6. As a rule, always fill alt text when uploading images to media library in WordPress

25. 16 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://bihnconstruction.com/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your homepage has 16 images without alt text — short descriptions that tell screen readers and search engines

what the image shows. This makes your site harder to navigate for people using accessibility tools, and search

engines can't index what's in those images, which reduces your SEO visibility.
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Why it matters for your business: Prospective clients using screen readers can't understand your portfolio

images, and Google can't rank you for image-based searches (e.g., 'commercial construction project in [city]'),

limiting organic discovery.

Technical root cause: Images were likely uploaded to WordPress without filling in the 'Alt Text' field in the

media library, or image blocks were inserted without the alt attribute populated.

Recommended fix — step by step

1. Log in to WordPress admin → Media Library.

2. Filter by 'Attached to: Bihn Construction' or browse the homepage media; click each image missing alt text.

3. In the 'Alt Text' field, write a short, descriptive phrase (e.g., 'Commercial steel-frame building under

construction' or 'Completed residential home exterior').

4. For portfolio/project images, include the project type or location if possible (helps SEO).

5. Save each image after editing.

6. Install the free plugin Yoast SEO (if not already active) → Tools → Site Health → re-scan to verify alt text is

now present.

7. Test with a screen reader tool like NVDA (free, Windows) or JAWS trial to confirm images are now described.

26. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/build-your-dream/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your 'Build Your Dream' page are missing alt text — descriptive labels that explain what the

image shows to people using screen readers and to search engines. This makes the page harder for visually

impaired visitors to navigate and reduces your SEO relevance for image-based searches.

Why it matters for your business: Missing alt text limits your visibility in Google Images search results, which

drives traffic to construction portfolio pages, and creates accessibility barriers that may expose you to legal risk

under ADA compliance standards.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the Media

Library, or the image blocks in the page editor were not configured with alt attributes.

Recommended fix — step by step

1. Log in to WordPress → Pages → Edit 'Build Your Dream'

2. Identify each image block and click it to open the block settings panel on the right

3. In the block settings, find the 'Alt Text' field under the Image section and write a descriptive 5–10 word

phrase describing what the image shows (e.g., 'Modern kitchen with white cabinets and granite

countertops')

4. Repeat for all 5 images

5. Click 'Update' to save the page

6. Optional: Go to Media Library → Library, select each image, and fill its Alt Text field there for consistency

across the site if these images are reused elsewhere

https://bihnconstruction.com/build-your-dream/


27. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/careers/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

All 5 images on your Careers page lack alt text—a text description that displays if an image fails to load and is

read aloud by screen readers for visitors with visual impairments. Without it, search engines can't understand

what the images show, and you're excluding potential employees who rely on assistive technology.

Why it matters for your business: Missing alt text reduces your page's SEO ranking for job-seeker searches

and signals to candidates that your company may not prioritize accessibility—potentially deterring qualified

applicants and exposing you to ADA compliance risk.

Technical root cause: Images were inserted into the page without the alt attribute populated during upload,

either directly in the HTML or via WordPress media insertion without filling the Alt Text field.

Recommended fix — step by step

1. Log in to WordPress admin → Pages → Careers

2. Click Edit or Edit with Gutenberg

3. For each image block, click the image to select it

4. In the right sidebar under Image settings, locate the Alt text field

5. Enter a concise, descriptive alt text (e.g., 'Team members collaborating on construction site' or 'Office

building exterior')

6. Repeat for all 5 images, ensuring each describes the visual content

7. Click Publish or Update to save changes

28. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/our-process/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your "Our Process" page are missing alt text—descriptive labels that explain what each image

shows. Search engines and assistive technology (like screen readers for people with vision loss) can't

understand images without these labels. This hurts both SEO ranking and user experience for a portion of your

audience.

Why it matters for your business: Missing alt text reduces search visibility for image-based queries and

excludes potential clients using assistive technology; it also creates legal liability under accessibility standards

(WCAG 2.1) that apply to public-facing websites.

Technical root cause: Images were inserted into WordPress without filling the Alt Text field during upload or

editing. WordPress stores alt text in the image metadata; if left blank, search engines see only a generic image
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file name.

Recommended fix — step by step

1. Log into WordPress Admin → go to Media Library → search for images used on /our-process/ page

2. For each image, click Edit, scroll to Alt Text field, and write a short descriptive phrase (8–12 words)

explaining what the image shows and its relevance to your construction process

3. Example: instead of leaving blank, write 'Excavation crew preparing foundation site with heavy equipment'

4. After filling alt text, click Update and verify the change is live by visiting the page in an incognito browser

5. Optional: Use Yoast SEO plugin (free version) → go to any page → scroll to Image SEO section to see a

checklist of images needing alt text

29. 11 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://bihnconstruction.com/services/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your services page has 11 images without alt text — short descriptions that explain what each image shows.

Search engines and screen readers (used by people with vision loss) can't understand unlabeled images, which

hurts both accessibility and how Google ranks your pages.

Why it matters for your business: Missing alt text reduces your search visibility for services pages and

excludes potential clients using assistive technology; it also signals poor site quality to search engines.

Technical root cause: Images were uploaded to WordPress without filling in the alt text field in the media

library, or alt attributes were never added to the image blocks/shortcodes in the page editor.

Recommended fix — step by step

1. Log into WordPress admin → go to /services/ page → click Edit

2. For each image block, click the image → click the settings icon (gear) in the top right → scroll to 'Alt text'

field

3. Write a 5–10 word description for each image (e.g., 'Concrete foundation being poured for residential home'

instead of 'image1.jpg')

4. Alternatively, go to Media Library → find each image → hover and click 'Edit' → fill 'Alternative Text' field →

Update

5. Publish/save the page changes

6. Verify: use WordPress SEO plugin (Yoast SEO or Rank Math) → run page analysis → confirm all images show

green checkmarks for alt text

30. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/services/commercial-construction/

https://bihnconstruction.com/services/
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Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your Commercial Construction services page don't have alt text — descriptive text that explains

what's in each image. Search engines and screen readers (used by people with visual impairments) can't

understand image content without it. This means you're missing SEO signals and excluding potential customers

who rely on assistive technology.

Why it matters for your business: Missing alt text reduces your page's ranking potential for image-related

searches and makes your site inaccessible to customers using screen readers, limiting your addressable market

and creating legal liability under accessibility standards.

Technical root cause: Images were likely uploaded to WordPress without filling the Alt Text field in the media

library, or the image blocks in the page editor lack alt attributes.

Recommended fix — step by step

1. Log into WordPress admin → navigate to https://bihnconstruction.com/wp-admin/upload.php (Media Library)

2. Search for images used on /services/commercial-construction/ (filter by date uploaded or use search)

3. For each image, click to open its details panel and fill the Alt Text field with a descriptive, keyword-relevant

phrase (e.g., 'Commercial steel-frame building under construction' instead of 'image123')

4. Alternatively, go to the page editor (Pages → Commercial Construction), click each image, and add alt text in

the Image Block settings on the right sidebar

5. Verify the fix by visiting the page in an incognito browser and using a browser extension like WAVE

(wave.webaim.org) to confirm all 6 images now have alt text

6. Repeat this process for any other image-heavy pages (portfolio, gallery sections)

31. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/services/project-management/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Project Management services page have no alt text—descriptive text that appears when

images fail to load and helps screen readers describe images to visually impaired visitors. This creates a barrier

for accessibility and gives search engines no information about what those images show.

Why it matters for your business: Missing alt text reduces your page's search ranking potential, prevents

visually impaired prospects from understanding your project examples, and exposes you to accessibility

compliance risk if your site is audited under ADA standards.

Technical root cause: Images were inserted into the page without alt text attributes being filled in during

upload or post editing. WordPress allows alt text to be left blank, so it requires intentional completion during

content creation.

Recommended fix — step by step

1. Log into WordPress admin → Pages → Project Management (or find via search).

2. In the page editor, locate each image and click it to open the image properties panel.

https://bihnconstruction.com/wp-admin/upload.php
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3. In the 'Alt text' field, write a concise, descriptive phrase (3–10 words) describing what the image shows—

e.g., 'Team reviewing construction blueprints on site' or 'Completed commercial renovation interior'.

4. For project/portfolio images, include the project type or key detail so search engines understand your

service scope.

5. Save/update the page.

6. Use a free tool like WAVE (wave.webaim.org) to verify all images now have alt text.

32. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/services/home-renovations-and-remodels/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your home renovations page don't have alt text — descriptive labels that explain what each image

shows. This makes those images invisible to screen readers (tools people with vision disabilities use to browse

the web) and also means search engines can't understand what those images depict, which hurts your ability to

rank for image-based searches.

Why it matters for your business: Potential customers using screen readers may miss key visual examples of

your renovation work, and you're losing SEO value from image search traffic that could drive qualified leads.

Technical root cause: Images were uploaded to WordPress without filling in the alt text field during upload or in

the image settings, so the HTML renders without alt attributes.

Recommended fix — step by step

1. Log into WordPress admin → go to Media Library → search for images used on the home-renovations-and-

remodels page

2. Click each image → in the right panel, locate the 'Alt Text' field and add a concise, descriptive label (e.g.,

'Master bedroom remodel with custom tile shower and new cabinetry')

3. For each image, ensure alt text is 8–15 words and describes what's visually important, not just 'image' or

'photo'

4. After editing all 6 images, visit the page on the front end and use a browser extension like WAVE or

Lighthouse (Chrome DevTools → Lighthouse) to verify alt text is now applied

5. Set a WordPress task reminder to review alt text for any new images added in future renovations or project

updates

33. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/government-civic/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)
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All 6 images on your Government & Civic Services page are missing alt text—descriptive labels that screen

readers use to describe images to visually impaired visitors, and that search engines use to understand image

content. Without alt text, these images are invisible to both accessibility tools and search bots.

Why it matters for your business: Missing alt text reduces your page's SEO ranking for image search (which

drives referral traffic) and creates legal accessibility liability under ADA/WCAG standards, risking complaints or

lawsuits.

Technical root cause: Images were inserted into WordPress without filling the 'Alt Text' field in the media

library or image block settings during upload or page editing.

Recommended fix — step by step

1. Log into WordPress admin → Pages → Government & Civic Services (edit)

2. For each image in the page editor, click the image to select it

3. In the right sidebar, locate the 'Alt Text' field (usually under Image settings or in a block inspector panel)

4. Write a concise, descriptive alt text for each image (e.g., 'Team meeting at city council chambers' or

'Construction site permit documentation')

5. Ensure alt text describes the image content and its relevance to your services (50–125 characters)

6. Click 'Update' to save the page

7. Test with a screen reader (free: NVDA on Windows, built-in VoiceOver on Mac) or use WordPress

accessibility checker plugin like Accessibility Checker by WPSP

34. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/multi-family/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your multi-family project page have no alt text — descriptive text that appears if an image fails to

load and that screen readers use to describe images to vision-impaired visitors. Without alt text, search engines

can't understand what these images show, and people using assistive technology get no context.

Why it matters for your business: Missing alt text reduces SEO ranking potential for project showcase pages,

limits accessibility for potential clients with disabilities (a legal compliance issue under WCAG standards), and

reduces image discoverability in Google Images.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field during upload or

via the media library. WordPress does not auto-generate meaningful alt text.

Recommended fix — step by step

1. Log into WordPress admin → Media Library → search for images used on the multi-family project page

2. Click each image and open its details panel on the right

3. In the 'Alt Text' field, write a short descriptive phrase (e.g., 'Multi-family residential building exterior with

modern facade' or 'Construction crew installing structural beams')

4. Click 'Update' for each image

5. Alternatively, go to the multi-family project page in edit mode, click each image in the content, and update

the Alt Text field directly in the image properties dialog
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6. After updating all 6 images, republish the page

7. Test using a free tool like WAVE (wave.webaim.org) to verify alt text is now present

35. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/higher-education/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Higher Education project page lack alt text — descriptive labels that screen readers read

aloud to blind users and that search engines use to understand image content. This blocks both accessibility

compliance and a small SEO benefit from image search.

Why it matters for your business: Inaccessible pages create legal risk under ADA/AODA and exclude potential

clients using assistive technology; missing alt text also reduces your chances of ranking in Google Images for

relevant project searches.

Technical root cause: Images were inserted into the WordPress editor without filling in the Alt Text field during

upload or when editing the page.

Recommended fix — step by step

1. Log in to WordPress → Pages → Edit 'Higher Education' page

2. In the page editor, click each image block to select it

3. In the right sidebar under 'Image Settings' → find the 'Alt Text' field (or 'Alternative Text')

4. Write a short, descriptive phrase for each image (e.g., 'Modern higher-education building facade with glass

exterior' or 'University lecture hall with tiered seating')

5. Repeat for all 6 images, then click 'Update' to save the page

6. After fixing, run the page through a free accessibility checker like WAVE (wave.webaim.org) to confirm alt

text is present

36. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/office-interiors/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

All 6 images on your Office Interiors page lack alt text — the short descriptions that help both screen-reader

users and search engines understand what each image shows. Without alt text, visually impaired visitors can't

know what they're looking at, and search engines can't index those images for image search results.

Why it matters for your business: Missing alt text reduces accessibility compliance risk, limits your visibility in

Google Image Search (a source of qualified traffic for construction/design work), and weakens SEO signals for

that page.
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Technical root cause: Images were uploaded or added to the page without filling in the alt text field in

WordPress. This is a common oversight when bulk-uploading media.

Recommended fix — step by step

1. Log into WordPress admin and go to Media Library → Search for images used on /office-interiors/

2. Click each image and fill in the 'Alt Text' field (under 'Attachment Details') with a brief, descriptive phrase

(e.g., 'Modern open-plan office with glass partitions and natural lighting')

3. Alternatively, go to Pages → Office Interiors → edit, and click each image block → click the image → fill 'Alt

text' in the right sidebar

4. Ensure alt text describes the image content and includes relevant keywords (e.g., 'office design',

'construction', 'interior renovation') where natural

5. Save and publish the page

6. Use a free tool like WAVE (wave.webaim.org) to re-scan the page and confirm all images now have alt text

37. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/parks-recreation/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Parks & Recreation project page don't have alt text—descriptive labels that explain what's in

each image. Search engines can't read images, so without these labels, Google can't understand what your

photos show. People using screen readers (tools that read web pages aloud for visually impaired visitors) also

hear nothing for these images.

Why it matters for your business: Missing alt text hurts your Google rankings for construction + landscape

project searches, and makes your site inaccessible to people with vision disabilities—both reducing traffic and

potential client inquiries.

Technical root cause: Images were uploaded to WordPress without alt text filled in during upload, or alt text

fields were left blank when the page was created.

Recommended fix — step by step

1. Log into WordPress admin → go to the Parks & Recreation page → click 'Edit'

2. In the page editor, click each image to select it

3. In the right-side image properties panel (or popup), find the 'Alt Text' field and enter a clear, specific

description (e.g., 'Aerial view of newly landscaped community park with walking paths' instead of just 'park

photo')

4. After filling alt text for all 6 images, click 'Update' to save

5. Optionally: install the free 'Yoast SEO' plugin (Plugins → Add New → search 'Yoast SEO' → Install &

Activate), which flags missing alt text on every page going forward

38. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)
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Business category: accessibility

Page URL: https://bihnconstruction.com/arts-entertainment/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Arts & Entertainment project page lack alternative text (alt text) — a short description that

appears when an image doesn't load and helps screen readers describe images to visually impaired visitors.

This makes the page harder for people using assistive technology to navigate, and search engines cannot

understand what those images show.

Why it matters for your business: Missing alt text reduces your project page's SEO ranking for image search,

limits accessibility for disabled visitors (a legal compliance risk), and reduces overall page quality signals that

Google uses to rank construction portfolio pages.

Technical root cause: Images were added to the page without the alt attribute being populated in the

WordPress image block or media settings. This is typically an oversight during content creation rather than a

platform limitation.

Recommended fix — step by step

1. Log in to WordPress admin → navigate to Pages → find 'Arts & Entertainment'

2. Click Edit to open the page in the block editor

3. Locate each image block and click it to select it

4. In the right sidebar, find the 'Alt text' field under the image settings (or click the image icon and look for

'Alternative text')

5. Write a brief, descriptive alt text for each image (e.g., 'Modern glass office lobby with marble flooring' — 5–

12 words is ideal)

6. Repeat for all six images on that page

7. Click Publish or Update to save changes

8. Test with a screen reader (NVDA for Windows, free) or use the WAVE browser extension to confirm alt text is

now present

39. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/fire-stations/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

All 6 images on your fire stations page are missing alt text—short text descriptions that describe what each

image shows. Screen readers (used by people with vision loss) can't tell visitors what these images are. Search

engines also can't understand image content without alt text, which means you're losing potential search traffic

from image searches.

Why it matters for your business: Missing alt text reduces your visibility in image search results for

construction and fire station projects, and excludes visitors using assistive technology—both of which shrink

your addressable audience.
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Technical root cause: Images were inserted into the page without adding descriptive alt attributes in the image

HTML or WordPress media settings.

Recommended fix — step by step

1. Log into WordPress and open the fire-stations page for editing

2. Click each image in the page editor to open its properties panel

3. For each image, locate the 'Alt Text' field and enter a clear, specific description (e.g., 'Fire station exterior

with red brick facade and three apparatus bays' rather than 'fire station')

4. Ensure descriptions are 5–15 words and describe what the image shows, not generic labels

5. Save the page and re-run an accessibility checker (use free tools like WAVE or Axe DevTools browser

extension) to verify all alt text is now present

40. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://bihnconstruction.com/stream-ecosystem-restoration/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your website is missing alternative text (alt text) — a brief description that appears if the image

doesn't load and that screen readers use to describe images to visually impaired visitors. On this page, all 6

images lack this description, making the content inaccessible and invisible to search engines.

Why it matters for your business: Missing alt text reduces your search engine visibility for image-based

queries, blocks potential clients using assistive technology, and creates legal liability under accessibility laws

(WCAG 2.1 AA, ADA).

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field in the media

uploader, or the images were inserted via HTML without alt attributes.

Recommended fix — step by step

1. Go to WordPress Admin → Media Library, find each image used on /stream-ecosystem-restoration/, and click

to edit it.

2. In the 'Alt Text' field, write a concise 5–10 word description of what the image shows (e.g., 'Restored stream

channel with native vegetation and flowing water').

3. Save each image after adding alt text.

4. If images are embedded in the page content, verify in the page editor (block or classic) that the alt field is

filled; if blank, add descriptive text there instead.

5. Test using a free tool like WAVE (wave.webaim.org) to confirm alt text is now present.

6. Audit remaining pages on your site for the same issue using WordPress plugins like Accessibility Checker or

AIOSEO, which flag missing alt text during editing.

41. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)
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Business category: seo

Page URL: https://bihnconstruction.com/pump-stations/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your pump stations page have no alt text—descriptive captions that tell search engines and

visitors using screen readers what those images show. Without alt text, those images are invisible to search

engines and inaccessible to people using assistive technology, which limits both discoverability and usability.

Why it matters for your business: Missing alt text reduces your SEO rankings for image searches (a growing

traffic source for construction firms), blocks potential clients using screen readers, and creates legal

accessibility risk under ADA/WCAG standards.

Technical root cause: Images were likely uploaded and inserted into the page without filling in the alt text field

in WordPress's image editor, or a theme/plugin is stripping alt attributes on output.

Recommended fix — step by step

1. Log into WordPress admin → go to Posts → Pages and open the pump-stations page in the editor

2. Click each image in the page content to select it

3. In the right sidebar under 'Image Settings,' locate the 'Alt Text' field and enter a descriptive phrase (e.g.,

'Industrial pump station installation in concrete foundation' not just 'pump')

4. Repeat for all 6 images, then click 'Update'

5. If you cannot see alt text fields in the editor, switch to the Classic Editor plugin (WordPress.com/plugins) and

repeat steps 2–4

6. After saving, use a free tool like WAVE (wave.webaim.org) to re-scan the page and confirm all 6 images now

have alt text

42. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/reservoirs-dams/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Reservoirs & Dams page have no alt text—short descriptions that tell screen readers and

search engines what the image shows. This blocks people using screen readers from understanding your

project photos, and search engines can't index the content of those images for image search.

Why it matters for your business: Missing alt text reduces your visibility in Google Image Search (a source of

qualified project leads) and excludes potential clients with visual impairments from understanding your portfolio

work.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field during upload or

in the Media Library. WordPress does not auto-generate alt text; it must be manually entered.

Recommended fix — step by step

1. Log into WordPress admin → Media Library
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2. Filter or search for images used on the Reservoirs & Dams page (or visit the page, right-click an image, and

note the filename)

3. For each image, click it in the Media Library → open the Alt Text field on the right sidebar → write a clear,

descriptive 5–10 word description (e.g., 'Concrete dam structure with water spillway, aerial view')

4. Click Update after each image

5. After updating all 6 images, visit the live page in an incognito browser and use a screen reader (NVDA or

JAWS) or a free tool like WAVE (wave.webaim.org) to confirm alt text is present

43. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/utility-infrastructure/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Utility Infrastructure page lack alt text — descriptive text that explains what each image

shows. Search engines and screen readers (used by people with vision loss) can't understand images without

this text. This means people using assistive technology miss important visual information, and search engines

can't index what's in those photos.

Why it matters for your business: Missing alt text reduces your page's search ranking potential for project-

related keywords, and makes your site inaccessible to a segment of users — which is both a business and legal

risk in many jurisdictions.

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field in the media

library or image block editor. WordPress requires manual entry of alt text; it doesn't auto-generate it.

Recommended fix — step by step

1. Log in to WordPress → navigate to https://bihnconstruction.com/utility-infrastructure/ in edit mode

2. Click each image block → in the right sidebar, locate the 'Alt text' field and enter a concise, descriptive

phrase (e.g., 'Excavated utility trench with PVC conduit installation' not 'image1')

3. If images are in a gallery, click the gallery → click Edit Gallery → click each image thumbnail and add alt text

in the modal

4. For bulk images, go to WordPress Admin → Media Library → click each image → scroll to 'Alternative Text'

field and fill it in

5. After updating all six images, republish the page and clear any caching plugin (if using one like WP Super

Cache)

44. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/site-development/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)
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Six images on your Site Development page lack alt text — descriptive labels that screen readers use to explain

images to visually impaired visitors, and that search engines use to understand image content. This affects both

accessibility (your site becomes harder to use for people with vision disabilities) and SEO (search engines can't

index what these images show).

Why it matters for your business: Missing alt text reduces your site's ranking potential for image search,

excludes customers using assistive technology, and creates legal risk under accessibility laws like the ADA.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field in the Media

Library, or the alt attribute was not populated when the image was inserted into the page.

Recommended fix — step by step

1. Log in to WordPress admin → go to Media Library → search for images used on /site-development/ page

2. For each of the 6 images, click the image → fill the Alt Text field with a short, descriptive phrase (e.g.,

'Excavator clearing foundation site' instead of 'site photo')

3. Alternatively, edit the Site Development page directly → click each image block → in the right sidebar under

Image Settings, fill Alt Text

4. Test the fix: visit the page, right-click an image → Inspect → verify the img tag contains alt="[your text]"

5. Repeat for any other pages with missing alt text (run another scan to confirm)

45. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/parks-trails/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on the Parks & Trails page lack alt text—descriptive text that screen readers use to describe images

to visually impaired visitors, and that search engines use to understand what the image shows. Without alt text,

those images are invisible to both accessibility tools and search algorithms.

Why it matters for your business: Missing alt text reduces your SEO ranking for image-related searches,

blocks potential clients using screen readers from understanding your project work, and creates legal exposure

under accessibility compliance standards (WCAG 2.1).

Technical root cause: Images were likely uploaded to WordPress without the alt text field being filled in during

upload, or the theme template does not enforce alt text as a required field.

Recommended fix — step by step

1. Log into WordPress admin → navigate to Media library

2. Search for or filter images used on the Parks & Trails page (/parks-trails/)

3. For each of the 6 images, click to open the image details modal and fill in the 'Alt Text' field with a

descriptive phrase (e.g., 'Paved hiking trail through oak grove' or 'Park bench overlooking valley vista')

4. Ensure each alt text is 5–125 characters and describes what the image shows, not just 'image' or 'photo'

5. Save each image and verify the page reloads with alt text applied

6. Install and activate the free plugin 'WP Accessibility' (wordpress.org/plugins/wp-accessibility/) and enable

'Enforce Alt Text' to prevent future uploads without alt descriptions
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46. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/pedestrian-bridges/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your pedestrian bridges page lack alt text—a short text description that appears if an image fails

to load and that screen readers use to describe images to blind/low-vision visitors. Search engines also use alt

text to understand what images show, which helps your site rank for relevant image searches.

Why it matters for your business: Missing alt text reduces your visibility in Google Images search, limits

accessibility to potential clients using assistive technology, and signals to search engines that your content is

incomplete—all of which suppress organic traffic and exclude qualified leads.

Technical root cause: Images were likely uploaded to WordPress without filling in the alt text field in the media

library, or the alt text field was left empty during page creation.

Recommended fix — step by step

1. Log into WordPress admin → go to Media Library → filter for images used on the pedestrian-bridges page

2. For each of the 6 images, click to open the image details and scroll to the 'Alt Text' field in the right panel

3. Write concise, descriptive alt text (5–10 words) that describes what the image shows and relates to

pedestrian bridge construction (e.g., 'Cable-stayed pedestrian bridge over urban plaza' or 'Worker installing

bridge deck supports')

4. Save each image after updating alt text

5. Alternatively, use the WordPress plugin 'WP Accessibility Helper' or 'SEO by Yoast' → set up bulk alt text

suggestions to catch future uploads

47. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/custom-homes/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Custom Homes page don't have alt text — descriptive text that explains what each image

shows. This matters for two reasons: people using screen readers (accessibility software that reads pages

aloud) won't know what those images depict, and search engines like Google can't understand the images

either, so they can't rank your pages as well for relevant searches.

Why it matters for your business: Missing alt text reduces your search visibility for image-based queries (e.g.,

'custom home construction') and excludes visitors using assistive technology, shrinking your potential customer

base.

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field in the media

library or image block settings. WordPress requires manual entry of alt text for each image.
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Recommended fix — step by step

1. Log in to WordPress Admin → go to Media Library → filter for images used on /custom-homes/ or navigate

directly to the page editor for that page.

2. For each of the 6 images, click the image in the editor, then in the right-hand panel under 'Image settings' or

'Image block' find the 'Alt text' field.

3. Write concise, descriptive alt text for each image (e.g., 'Modern two-story custom home with stone and

siding exterior' not just 'House' or 'Image 1').

4. Include relevant keywords naturally when possible (e.g., 'custom home construction detail' rather than

generic descriptions).

5. Click 'Update' or 'Save' on the page after adding alt text to each image.

6. Use the WordPress Accessibility Checker plugin (free) or Yoast SEO's built-in accessibility check to verify all

images now have alt text before publishing.

48. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/lake-mountain-properties/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Images on your Lake Mountain Properties page are missing alt text—a short text description that screen readers

use to tell visually-impaired visitors what an image shows, and that search engines use to understand your

content. All 6 images on this page lack these descriptions.

Why it matters for your business: Missing alt text reduces your search visibility for image-based queries (e.g.,

'mountain property construction photos') and excludes visitors using screen readers, shrinking your potential

audience and harming SEO rankings.

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field in the media

uploader, or they were inserted via HTML without an alt attribute.

Recommended fix — step by step

1. Log into WordPress Admin → Media Library, find each image used on the Lake Mountain Properties page,

click Edit, and fill in the Alt Text field with a 5–10 word description (e.g., 'Mountain lodge exterior during

construction phase').

2. Alternatively, go to Pages → Lake Mountain Properties → Edit, hover over each image in the editor, click the

image, and add alt text in the right-side image settings panel under 'Alternative Text'.

3. For each image, write alt text that describes what's shown and includes relevant keywords (e.g., 'completed

residential construction project in mountain terrain' rather than 'image1.jpg').

4. After updating all 6 images, click Publish or Update, then visit the page in an incognito browser and use a

free tool like WAVE (wave.webaim.org) to verify all images now have alt text.

5. Optional: Use the Yoast SEO plugin (likely already installed) → go to the Lake Mountain Properties post,

check the Image SEO section for any remaining alt-text warnings, and address them.

49. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH
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Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/specialty-features/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Specialty Features page are missing alt text — descriptive text that explains what each

image shows. This text is read aloud by screen readers used by visually impaired visitors, and search engines

use it to understand image content. Without it, those images are invisible to both assistive technology users and

search engines.

Why it matters for your business: Missing alt text reduces your page's ability to rank for image-related

searches and excludes visually impaired potential clients from understanding your specialty services, limiting

your addressable audience.

Technical root cause: Images were uploaded to WordPress without alt text being filled in during the upload

process or in the Media Library. WordPress requires manual entry of alt text for each image.

Recommended fix — step by step

1. Log in to WordPress admin → Media Library → find all images on the Specialty Features page

2. For each image, click to open it and scroll to the 'Alt Text' field

3. Write a concise, descriptive phrase (5–10 words) for each image—e.g., 'Custom kitchen renovation with

quartz countertops' instead of 'kitchen'

4. Click 'Update' to save each alt text entry

5. Alternatively, go to Pages → Specialty Features → Edit, hover over each image in the editor, click the image,

and fill the Alt Text field in the right sidebar

6. After saving, run a quick accessibility check using the free WAVE browser extension to confirm all alt text is

in place

50. 6 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/parking-structures/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your parking structures page has 6 images that lack alt text — descriptive labels that screen readers use to tell

visually impaired visitors what each image shows. This also means search engines can't understand what's in

those photos, so they won't appear in Google Images and won't contribute SEO value.

Why it matters for your business: Missing alt text reduces your visibility in Google Images search (potential

lead source for construction projects) and makes your site inaccessible to people using screen readers, which

could expose you to accessibility complaints and limits your addressable audience.

Technical root cause: Images were uploaded to WordPress without filling in the alt text field during upload, or

the image blocks were added without the alt attribute populated in the HTML.

Recommended fix — step by step
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1. Log in to WordPress admin and go to Media Library; search for images used on the parking structures page.

2. For each image, click to open its details panel and fill the 'Alt Text' field with a clear, descriptive 2–8 word

phrase (e.g., 'Multi-level parking structure with concrete supports' rather than 'image' or leaving it blank).

3. Alternatively, edit the parking structures page in the block editor, click each image block, and fill the alt text

field in the right sidebar under 'Image settings.'

4. Save and publish the page.

5. Use a free tool like WAVE (wave.webaim.org) or plug the page URL into axe DevTools (browser extension) to

confirm all images now have alt text.

51. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/contact-us/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your Contact Us page is missing alt text — descriptive text that screen readers announce to

visitors with visual impairments, and that search engines use to understand what an image shows. This means

blind or low-vision visitors cannot access information conveyed only in images, and Google cannot index image

content to help your site rank for relevant searches.

Why it matters for your business: Missing alt text blocks potential clients (those using assistive technology)

from understanding your services, reduces search engine visibility for image-based content, and creates legal

exposure under accessibility compliance standards like WCAG 2.1.

Technical root cause: Images were inserted into the WordPress page without filling in the 'Alt Text' field in the

image block or legacy media settings. This is a content-entry issue, not a code bug.

Recommended fix — step by step

1. Log into WordPress Admin → Pages → Contact Us (edit).

2. In the page editor, click the first image to select it.

3. In the right sidebar under 'Image Settings' or 'Block Settings', locate the 'Alt Text' field.

4. Write a concise, descriptive alt text (e.g., 'Bihn Construction team member on job site' or 'Heavy machinery

at construction site') — aim for 10–15 words; do not repeat the filename.

5. Repeat steps 2–4 for all 7 images on the page.

6. Click 'Update' or 'Publish' to save changes.

7. Open Chrome DevTools (right-click image → Inspect) and verify the alt attribute is present in the <img> tag.

52. 17 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://bihnconstruction.com/commercial/

Rule: tier2.a11y.img-missing-alt
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What it means (plain English)

All 17 images on your Commercial page are missing alt text — descriptive labels that screen readers use to tell

blind/low-vision visitors what an image shows. Search engines also read alt text to understand your content

better. This is both an accessibility barrier and a missed SEO signal.

Why it matters for your business: Visitors using screen readers cannot understand your project photos,

reducing inclusivity; Google cannot index image content as effectively, lowering your search visibility for

construction project keywords.

Technical root cause: Images were uploaded to WordPress without alt text filled in during the media upload or

inserted into pages without the alt attribute populated in the image block settings.

Recommended fix — step by step

1. In WordPress admin, go to Media Library and filter by 'Commercial' page context or bulk-review images used

on /commercial/

2. For each image, click to edit, scroll to 'Alt Text' field, and write 1–10 words describing what's shown (e.g.,

'Commercial office renovation with new glass entrance' instead of leaving blank)

3. Alternatively, open /commercial/ in the WordPress block editor, click each image block, and fill the 'Alt text'

field in the right sidebar

4. Focus first on images that show finished projects, unique design elements, or before/after comparisons—

these carry the most SEO + user value

5. After updating, run a quick re-scan using a free tool like WAVE (wave.webaim.org) or axe DevTools browser

extension on /commercial/ to confirm alt text is live

6. Document which images serve which purpose (e.g., 'hero image = project overview', 'interior = flooring

detail') so future edits stay consistent

53. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/portfolio/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your Portfolio page lack alt text—a short description that screen readers use to tell visually

impaired visitors what an image shows, and that search engines use to understand your content. This is both an

accessibility barrier and a missed SEO opportunity, since Google can't index what it can't read.

Why it matters for your business: Potential customers using assistive technology can't engage with your

portfolio work, and search engines may rank these images lower or skip them entirely, reducing discoverability

of your best project examples.

Technical root cause: Images were likely uploaded to WordPress without filling in the Alt Text field in the media

library, or the theme template doesn't enforce alt text on images.

Recommended fix — step by step

1. Log in to WordPress admin → go to Media Library → filter by 'Unattached' or search for images used on

/portfolio/

2. Open each of the 5 portfolio images and click Edit → scroll to Alt Text field → write a clear, descriptive

phrase (e.g., 'Modern kitchen renovation with white cabinetry and granite countertops') → click Update
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3. Alternatively, navigate to Portfolio page in the page editor → click each image block → fill in Alt Text in the

right sidebar → save page

4. Install and activate the free plugin 'WP Smush' → go to WP Smush → Bulk Smush → check 'Auto alt-text' to

auto-generate captions for future uploads

5. Test with a screen reader (free: NVDA for Windows, built-in VoiceOver for Mac) to confirm alt text reads

naturally

54. 5 image(s) missing alt text

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/kitchen-remodel-design-counter-top-pantry/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your kitchen remodel page don't have alt text—descriptive labels that explain what the image

shows. Search engines and screen readers (used by people with vision impairments) can't understand

unlabeled images, which means they miss important content about your work.

Why it matters for your business: Missing alt text reduces your visibility in Google Images search results for

kitchen remodels, and it excludes potential clients who use assistive technology from seeing your portfolio

work.

Technical root cause: Images were likely uploaded to WordPress without filling in the 'Alt Text' field in the

Media Library, or were added via HTML without the alt attribute populated.

Recommended fix — step by step

1. Log in to WordPress admin and go to Media Library

2. Search for or navigate to the kitchen remodel page's images

3. For each of the 5 images missing alt text, click the image to open its details panel

4. Fill the 'Alt Text' field with a descriptive phrase (e.g., 'Custom white quartz countertop with stainless steel

sink in remodeled kitchen' rather than 'kitchen counter')

5. Save each image and republish the page

6. Alternatively, use the WordPress Gutenberg editor on that page directly: click each image block → click the

image → enter alt text in the sidebar panel under 'Image Settings' → update the page

55. 5 image(s) missing alt text

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://bihnconstruction.com/custom-home-builder/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your custom home builder page are missing alt text — descriptive text that screen readers read

aloud and search engines use to understand what each image shows. This makes your site harder for people
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with vision disabilities to navigate, and it wastes an SEO opportunity since Google can't index those images as

well.

Why it matters for your business: Visitors using screen readers will skip over your project photos entirely,

reducing engagement and limiting your audience; also, Google ranks sites with better accessibility higher, so

this may be costing you search visibility for keywords like 'custom home builder.'

Technical root cause: Images were likely inserted into the page without filling in the alt text field during upload,

or the theme template doesn't require alt text entry in the image block settings.

Recommended fix — step by step

1. Log into WordPress → go to Pages → edit 'Custom Home Builder' page

2. Switch to Visual/Block editor view and locate the 5 images without alt text

3. For each image, click it → look for an 'Alt text' field in the right sidebar (under Image settings)

4. Write 5–10 word descriptive alt text for each (e.g., 'Modern kitchen with white cabinetry and granite

countertops' instead of 'kitchen')

5. Install the free Yoast SEO plugin if not already active → it will flag missing alt text on pages you edit going

forward

6. After fixing these 5, run a full site scan: Yoast SEO → Site health → Image optimization report to catch any

others

56. 6 image(s) missing alt text

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/waste-water-treatment/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your waste-water treatment page don't have alt text — descriptive labels that tell search engines

and screen readers what each image shows. This breaks accessibility for people using screen readers and

weakens your SEO because search engines can't understand what those images depict.

Why it matters for your business: You're losing SEO value for image search traffic, and visitors using assistive

technology can't access key visual information about your services — both hurt lead generation.

Technical root cause: Images were uploaded to WordPress without filling in the Alt Text field during the media

library upload or post editor process.

Recommended fix — step by step

1. Go to WordPress Dashboard → Posts → waste-water treatment page → Edit

2. Scroll down or use the Inspector to find the first image block; click it and locate the 'Alt text' field in the right

sidebar

3. Write a concise, descriptive alt text (e.g., 'wastewater treatment tank installation' or 'industrial pipe

maintenance for waste management') — avoid 'image' or 'photo'

4. Repeat for all 6 images on that page

5. Click Publish or Update to save changes

6. Do the same audit on other service pages (construction, project portfolio, etc.) to fix alt text site-wide

https://bihnconstruction.com/waste-water-treatment/


7. Consider enabling a WordPress SEO plugin like Yoast SEO (free version) which flags missing alt text during

editing

57. 6 image(s) missing alt text

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://bihnconstruction.com/additions-renovations/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Six images on your Additions & Renovations page don't have descriptive alt text. Alt text is the hidden text that

describes an image; it helps people using screen readers understand what's shown, and it also helps search

engines index your images correctly.

Why it matters for your business: Missing alt text reduces your page's visibility in image search results and

makes your site harder to use for visitors with visual impairments—both of which hurt credibility and SEO

ranking.

Technical root cause: Images were likely uploaded or inserted into the page without adding alt text in the

WordPress media editor or image block settings.

Recommended fix — step by step

1. Log into WordPress → go to Pages → edit 'Additions & Renovations'

2. Switch to Visual editor view, then click the first image to select it

3. Click the Edit button (pencil icon) on the selected image, then scroll to the 'Alt Text' field

4. Write a concise, descriptive phrase (e.g., 'Kitchen renovation with new cabinets and countertops') rather

than just the filename

5. Click Update, then repeat for all 6 images on this page

6. Publish or Update the page when done

7. Check your Google Search Console (Search Appearance → Images) to confirm images begin appearing in

search results over the next 2 weeks

58. 5 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/high-end-home-builder-in-south-carolina/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

59. 5 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/services/design-build-services/

Rule: tier2.a11y.img-missing-alt

https://bihnconstruction.com/additions-renovations/
https://bihnconstruction.com/high-end-home-builder-in-south-carolina/
https://bihnconstruction.com/services/design-build-services/


Detail

Images without alt fail a11y + hurt SEO.

60. 5 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/services/custom-home-construction/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

61. 6 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/services/additions-and-expansions/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

62. 6 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/hospitality/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

63. 6 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/k-12-education/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

64. 6 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/faith-based/

Rule: tier2.a11y.img-missing-alt

Detail

https://bihnconstruction.com/services/custom-home-construction/
https://bihnconstruction.com/services/additions-and-expansions/
https://bihnconstruction.com/hospitality/
https://bihnconstruction.com/k-12-education/
https://bihnconstruction.com/faith-based/


Images without alt fail a11y + hurt SEO.

65. 6 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/clubhouses-community-amenities/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

66. 6 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/wastewater-water-treatment/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

67. 22 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/heavy-civil/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

68. 5 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/custom-residential/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

69. Missing meta description

Severity: P2

Page URL: https://bihnconstruction.com/category/construction/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://bihnconstruction.com/clubhouses-community-amenities/
https://bihnconstruction.com/wastewater-water-treatment/
https://bihnconstruction.com/heavy-civil/
https://bihnconstruction.com/custom-residential/
https://bihnconstruction.com/category/construction/


70. 5 image(s) missing alt text

Severity: P2

Page URL: https://bihnconstruction.com/category/construction/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

71. 1 broken internal link(s)

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier2.links.broken

Detail

Broken internal links degrade UX + crawl equity.

72. No H1 on homepage

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier4.h1.missing

Detail

Every page should have exactly one H1.

73. Missing core schema types: LocalBusiness

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier4.schema.missing-core

Detail

Every site should emit Organization + LocalBusiness + WebSite JSON-LD.

74. Missing security header: x-frame-options

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier5.header.x-frame-options

Detail

x-frame-options not present on homepage response. Affects fortress score and CSP posture.

https://bihnconstruction.com/category/construction/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/


75. Missing security header: content-security-policy

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier5.header.content-security-policy

Detail

content-security-policy not present on homepage response. Affects fortress score and CSP posture.

76. No DMARC policy published

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier5.fortress.dmarc-missing

Detail

No v=DMARC1 record at _dmarc.bihnconstruction.com. Without DMARC, spoofed email from your domain is

harder to filter. Start with p=none for monitoring.

77. 32 tap targets under 44px at mobile-320

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

78. 32 tap targets under 44px at mobile-375

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

79. 32 tap targets under 44px at mobile-414

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/


80. 28 tap targets under 44px at tablet-768

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

81. Lighthouse perf (mobile): 67/100

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier8.lighthouse.perf-mobile

Detail

Score 67 is below target 85. See HTML report for details.

82. A11y: Document should have one main landmark

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier9.a11y.landmark-one-main

Detail

Ensure the document has a main landmark

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/landmark-one-main?application=playwright

83. A11y: All page content should be contained by landmarks (×3)

Severity: P2

Page URL: https://bihnconstruction.com/

Rule: tier9.a11y.region

Detail

Ensure all page content is contained by landmarks

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/region?application=playwright

https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://dequeuniversity.com/rules/axe/4.11/landmark-one-main?application=playwright
https://bihnconstruction.com/
https://dequeuniversity.com/rules/axe/4.11/region?application=playwright


P3 — 48 findings

1. Missing OpenGraph metadata

Severity: P3

Page URL: https://bihnconstruction.com/blog/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

2. Title length 76 chars

Severity: P3

Page URL: https://bihnconstruction.com/home-renovation-contractors/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Home Renovation Contractors Services for Your Dream Home | Bihn

Construction"

3. Title length 87 chars

Severity: P3

Page URL: https://bihnconstruction.com/contractor-for-kitchen-remodel/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Choosing the Right Contractor for Kitchen Remodel: A Complete Guide | Bihn

Construction"

4. Title length 73 chars

Severity: P3

Page URL: https://bihnconstruction.com/small-kitchen-remodel-cost/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Small Kitchen Remodel Cost: Budgeting & Smart Savings | Bihn

Construction"

5. Missing OpenGraph metadata

Severity: P3

Page URL: https://bihnconstruction.com/small-kitchen-remodel-cost/

https://bihnconstruction.com/blog/
https://bihnconstruction.com/home-renovation-contractors/
https://bihnconstruction.com/contractor-for-kitchen-remodel/
https://bihnconstruction.com/small-kitchen-remodel-cost/
https://bihnconstruction.com/small-kitchen-remodel-cost/


Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

6. Title length 89 chars

Severity: P3

Page URL: https://bihnconstruction.com/kitchen-remodel-design-counter-top-pantry/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Kitchen Remodel Design Counter Top Pantry: Upgrades for a Modern Home |

Bihn Construction"

7. Title length 74 chars

Severity: P3

Page URL: https://bihnconstruction.com/new-construction-home-inspection/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Ultimate Guide to New Construction Home Inspection | Bihn

Construction"

8. Title length 87 chars

Severity: P3

Page URL: https://bihnconstruction.com/split-level-kitchen-remodel/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Split Level Kitchen Remodel: Balancing Functionality and Aesthetics | Bihn

Construction"

9. Title length 96 chars

Severity: P3

Page URL: https://bihnconstruction.com/flooring-contractor-insights/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Flooring Contractor Insights: A Complete Guide for a Successful Installation |

Bihn Construction"

10. Title length 74 chars

https://bihnconstruction.com/kitchen-remodel-design-counter-top-pantry/
https://bihnconstruction.com/new-construction-home-inspection/
https://bihnconstruction.com/split-level-kitchen-remodel/
https://bihnconstruction.com/flooring-contractor-insights/


Severity: P3

Page URL: https://bihnconstruction.com/pool-contractors/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Pool Contractors: Turning Backyard Dreams into Reality | Bihn Construction"

11. Title length 77 chars

Severity: P3

Page URL: https://bihnconstruction.com/basement-renovation-cost/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Basement Renovation Cost: Factors That Impact Your Budget | Bihn

Construction"

12. Title length 73 chars

Severity: P3

Page URL: https://bihnconstruction.com/whole-home-remodel/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Whole Home Remodel: Step-by-Step Planning for Success | Bihn

Construction"

13. Title length 86 chars

Severity: P3

Page URL: https://bihnconstruction.com/excavation-contractors/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Excavation Contractors: Informative Services Costs and Hiring Tips | Bihn

Construction"

14. Title length 78 chars

Severity: P3

Page URL: https://bihnconstruction.com/outdoor-home-renovations/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Outdoor Home Renovations: Boosting Functionality and Style | Bihn

Construction"

https://bihnconstruction.com/pool-contractors/
https://bihnconstruction.com/basement-renovation-cost/
https://bihnconstruction.com/whole-home-remodel/
https://bihnconstruction.com/excavation-contractors/
https://bihnconstruction.com/outdoor-home-renovations/


15. Title length 88 chars

Severity: P3

Page URL: https://bihnconstruction.com/fireplace-renovation/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Fireplace Renovation: Crafting the Perfect Centerpiece for Your Home | Bihn

Construction"

16. Title length 87 chars

Severity: P3

Page URL: https://bihnconstruction.com/custom-home-builder/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Custom Home Builder: The Ultimate Guide to Building Your Dream Home |

Bihn Construction"

17. Title length 87 chars

Severity: P3

Page URL: https://bihnconstruction.com/luxury-home-construction/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Luxury Home Construction: The Ultimate Guide from Vision to Reality | Bihn

Construction"

18. Title length 83 chars

Severity: P3

Page URL: https://bihnconstruction.com/design-build-contractors/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Design-Build Contractors: The Future of Construction Efficiency | Bihn

Construction"

19. Title length 72 chars

Severity: P3

Page URL: https://bihnconstruction.com/high-end-renovation/

Rule: tier2.meta.title-length

Detail

https://bihnconstruction.com/fireplace-renovation/
https://bihnconstruction.com/custom-home-builder/
https://bihnconstruction.com/luxury-home-construction/
https://bihnconstruction.com/design-build-contractors/
https://bihnconstruction.com/high-end-renovation/


Title should be 20-65 chars. Got: "Transform Your Space: The Art of High-End Renovation | Bihn Construction"

20. Title length 74 chars

Severity: P3

Page URL: https://bihnconstruction.com/major-home-remodel/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Major Home Remodel: What Every Homeowner Needs to Know | Bihn

Construction"

21. Title length 84 chars

Severity: P3

Page URL: https://bihnconstruction.com/the-essential-builders-guide-for-new-lot-owners/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "From Ground Up: The Essential Builder’s Guide for New Lot Owners | Bihn

Construction"

22. Title length 88 chars

Severity: P3

Page URL: https://bihnconstruction.com/custom-home-construction-at-lake-keowee-build-your-dream-

lake-house/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Custom Home Construction at Lake Keowee: Build Your Dream Lake House |

Bihn Construction"

23. Title length 78 chars

Severity: P3

Page URL: https://bihnconstruction.com/the-cliffs-custom-home-construction/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Cliffs Custom Home Construction: Build Your Dream Home | Bihn

Construction"

24. Title length 81 chars

Severity: P3

https://bihnconstruction.com/major-home-remodel/
https://bihnconstruction.com/the-essential-builders-guide-for-new-lot-owners/
https://bihnconstruction.com/custom-home-construction-at-lake-keowee-build-your-dream-lake-house/
https://bihnconstruction.com/custom-home-construction-at-lake-keowee-build-your-dream-lake-house/
https://bihnconstruction.com/the-cliffs-custom-home-construction/


Page URL: https://bihnconstruction.com/modern-custom-homes-upstate-sc-innovative-elegant-designs/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Modern Custom Homes Upstate SC | Innovative & Elegant Designs | Bihn

Construction"

25. Title length 99 chars

Severity: P3

Page URL: https://bihnconstruction.com/kitchen-renovation-greenville-sc-what-local-experts-wont-tell-

you-about-costs/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Kitchen Renovation Greenville SC: What Local Experts Won't Tell You About

Costs | Bihn Construction"

26. Description length 162 chars

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

27. Description length 17 chars

Severity: P3

Page URL: https://bihnconstruction.com/build-your-dream/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

28. Missing OpenGraph metadata

Severity: P3

Page URL: https://bihnconstruction.com/build-your-dream/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

29. Missing OpenGraph metadata

https://bihnconstruction.com/modern-custom-homes-upstate-sc-innovative-elegant-designs/
https://bihnconstruction.com/kitchen-renovation-greenville-sc-what-local-experts-wont-tell-you-about-costs/
https://bihnconstruction.com/kitchen-renovation-greenville-sc-what-local-experts-wont-tell-you-about-costs/
https://bihnconstruction.com/
https://bihnconstruction.com/build-your-dream/
https://bihnconstruction.com/build-your-dream/


Severity: P3

Page URL: https://bihnconstruction.com/careers/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

30. Missing OpenGraph metadata

Severity: P3

Page URL: https://bihnconstruction.com/our-process/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

31. Missing OpenGraph metadata

Severity: P3

Page URL: https://bihnconstruction.com/portfolio/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

32. Missing OpenGraph metadata

Severity: P3

Page URL: https://bihnconstruction.com/custom-residential/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

33. Missing OpenGraph metadata

Severity: P3

Page URL: https://bihnconstruction.com/category/construction/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

34. Heavy JS payload (mobile): 255KB

Severity: P3

https://bihnconstruction.com/careers/
https://bihnconstruction.com/our-process/
https://bihnconstruction.com/portfolio/
https://bihnconstruction.com/custom-residential/
https://bihnconstruction.com/category/construction/


Page URL: https://bihnconstruction.com/

Rule: tier3.weight.js-mobile

Detail

JavaScript transfer exceeds 250KB budget.

35. Heavy page weight (mobile): 73411KB

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier3.weight.total-mobile

Detail

Total transfer exceeds 2500KB budget.

36. Missing security header: x-content-type-options

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier5.header.x-content-type-options

Detail

x-content-type-options not present on homepage response. Affects fortress score and CSP posture.

37. Missing security header: referrer-policy

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier5.header.referrer-policy

Detail

referrer-policy not present on homepage response. Affects fortress score and CSP posture.

38. Missing security header: permissions-policy

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier5.header.permissions-policy

Detail

permissions-policy not present on homepage response. Affects fortress score and CSP posture.

39. SSL Labs grade: unknown

Severity: P3

Page URL: https://bihnconstruction.com/

https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/


Rule: tier5.fortress.ssl-grade

Detail

Qualys SSL Labs: SSL Labs HTTP 400. Aim for A+ via strong TLS 1.3, HSTS, CAA, and preload.

40. DNSSEC not enabled

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier5.fortress.dnssec-missing

Detail

DNSSEC adds cryptographic verification to DNS responses. Consider enabling via your registrar.

41. No CAA DNS records

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier5.fortress.caa-missing

Detail

CAA records restrict which CAs may issue certs for your domain, preventing rogue issuance. Add CAA for

letsencrypt.org / digicert.com / etc.

42. Lighthouse bestPractices (mobile): 82/100

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier8.lighthouse.bestPractices-mobile

Detail

Score 82 is below target 90. See HTML report for details.

43. LH mobile: Reduce initial server response time (Root document took

1,190 ms)

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier8.lh-opportunity.server-response-time-mobile

Detail

Keep the server response time for the main document short because all other requests depend on it.

https://developer.chrome.com/docs/lighthouse/performance/time-to-first-byte/" target="_blank"

rel="noreferrer">Learn more about the Time to First Byte metric.

44. LH mobile: Preload Largest Contentful Paint image

https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
https://bihnconstruction.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Bihn%20Construction/%3Ca%20href=


Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier8.lh-opportunity.prioritize-lcp-image-mobile

Detail

If the LCP element is dynamically added to the page, you should preload the image in order to improve LCP.

https://web.dev/articles/optimize-lcp#optimize_when_the_resource_is_discovered" target="_blank"

rel="noreferrer">Learn more about preloading LCP elements.

45. LH mobile: Defer offscreen images (Est savings of 42 KiB)

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier8.lh-opportunity.offscreen-images-mobile

Detail

Consider lazy-loading offscreen and hidden images after all critical resources have finished loading to lower

time to interactive. https://developer.chrome.com/docs/lighthouse/performance/offscreen-images/"

target="_blank" rel="noreferrer">Learn how to defer offscreen images.

46. LH mobile: Eliminate render-blocking resources (Est savings of 450 ms)

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier8.lh-opportunity.render-blocking-resources-mobile

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

47. LH mobile: Minify JavaScript (Est savings of 17 KiB)

Severity: P3

Page URL: https://bihnconstruction.com/

Rule: tier8.lh-opportunity.unminified-javascript-mobile

Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"

rel="noreferrer">Learn how to minify JavaScript.

48. A11y: Elements marked as presentational should be consistently

ignored

Severity: P3

Page URL: https://bihnconstruction.com/

https://bihnconstruction.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Bihn%20Construction/%3Ca%20href=
https://bihnconstruction.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Bihn%20Construction/%3Ca%20href=
https://bihnconstruction.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Bihn%20Construction/%3Ca%20href=
https://bihnconstruction.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Bihn%20Construction/%3Ca%20href=
https://bihnconstruction.com/


Rule: tier9.a11y.presentation-role-conflict

Detail

Ensure elements marked as presentational do not have global ARIA or tabindex so that all screen readers ignore

them

Impact: minor

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/presentation-role-conflict?application=playwright

Findings by Page

Grouped by URL — useful when working through the site one page at a time.

https://bihnconstruction.com/

_38 findings on this page_

[P1] Age gate not detected 🔴  DO FIRST

Your homepage does not display an age verification prompt asking visitors to confirm they are 21 or older

before accessing content. Cannabis retailers are legally required in most jurisdictions to gat

[P1] 2 mixed-content references (http://) 🟠  HIGH

Your site is served over HTTPS (secure), but it's linking to two resources via HTTP (insecure). Browsers will

either block these resources or show security warnings to visitors, which erodes trust and

[P1] Lighthouse perf (desktop): 0/100 🔴  DO FIRST

Your homepage is scoring 0/100 on Google's Lighthouse performance test, which measures how fast your site

loads and responds to user interactions. This suggests critical issues such as missing stylesh

[P1] Lighthouse a11y (desktop): 0/100 🔴  DO FIRST

Your website is scoring 0/100 on accessibility (a11y), meaning it has critical barriers preventing people with

disabilities from using it. This could include missing alt text on images, broken keyboar

[P1] Lighthouse bestPractices (desktop): 0/100 🔴  DO FIRST

Your site received a Lighthouse Best Practices score of 0/100, meaning it has critical issues affecting browser

compatibility, security, or code quality. This is not a cannabis-specific audit (your si

[P1] Lighthouse seo (desktop): 0/100 🔴  DO FIRST

Your homepage is receiving a zero SEO score from Lighthouse, which means search engines (Google, Bing)

cannot properly understand or index your site's content. This typically indicates missing critica

[P1] A11y: <html> element must have a lang attribute 🔴  DO FIRST

Your website's main HTML page is missing a lang  attribute on the <html>  tag. This attribute tells screen

readers and search engines what language your content is in. Without it, assistive technolo

[P1] Journey failed: default: homepage → age gate → menu visible 🔴  DO FIRST

https://dequeuniversity.com/rules/axe/4.11/presentation-role-conflict?application=playwright
https://bihnconstruction.com/
http://)/


Your website is throwing a 403 error (access denied) when loading a resource during the age-gate flow. This

means something on the page—likely a script, stylesheet, or image—is being blocked by your s

[P2] 16 image(s) missing alt text 🟠  HIGH

Your homepage has 16 images without alt text — short descriptions that tell screen readers and search engines

what the image shows. This makes your site harder to navigate for people using accessibili

[P2] 1 broken internal link(s)

[P2] No H1 on homepage

[P2] Missing core schema types: LocalBusiness

[P2] Missing security header: x-frame-options

[P2] Missing security header: content-security-policy

[P2] No DMARC policy published

[P2] 32 tap targets under 44px at mobile-320

[P2] 32 tap targets under 44px at mobile-375

[P2] 32 tap targets under 44px at mobile-414

[P2] 28 tap targets under 44px at tablet-768

[P2] Lighthouse perf (mobile): 67/100

[P2] A11y: Document should have one main landmark

[P2] A11y: All page content should be contained by landmarks (×3)

[P3] Description length 162 chars

[P3] Heavy JS payload (mobile): 255KB

[P3] Heavy page weight (mobile): 73411KB

[P3] Missing security header: x-content-type-options

[P3] Missing security header: referrer-policy

[P3] Missing security header: permissions-policy

[P3] SSL Labs grade: unknown

[P3] DNSSEC not enabled

[P3] No CAA DNS records

[P3] Lighthouse bestPractices (mobile): 82/100

[P3] LH mobile: Reduce initial server response time (Root document took 1,190 ms)

[P3] LH mobile: Preload Largest Contentful Paint image

[P3] LH mobile: Defer offscreen images (Est savings of 42 KiB)

[P3] LH mobile: Eliminate render-blocking resources (Est savings of 450 ms)

[P3] LH mobile: Minify JavaScript (Est savings of 17 KiB)

[P3] A11y: Elements marked as presentational should be consistently ignored

https://bihnconstruction.com/small-kitchen-remodel-cost/

_3 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your kitchen remodel cost page don't have alt text—descriptive labels that screen readers

announce to visitors with vision disabilities, and that search engines use to understand what i

[P3] Title length 73 chars

https://bihnconstruction.com/small-kitchen-remodel-cost/


[P3] Missing OpenGraph metadata

https://bihnconstruction.com/build-your-dream/

_3 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your 'Build Your Dream' page are missing alt text — descriptive labels that explain what the

image shows to people using screen readers and to search engines. This makes the page harder

[P3] Description length 17 chars

[P3] Missing OpenGraph metadata

https://bihnconstruction.com/category/construction/

_3 findings on this page_

[P2] Missing meta description

[P2] 5 image(s) missing alt text

[P3] Missing OpenGraph metadata

https://bihnconstruction.com/blog/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Your blog page has 5 images without alt text—short descriptions that screen readers use to tell visually

impaired visitors what an image shows. These missing descriptions also prevent search engines f

[P3] Missing OpenGraph metadata

https://bihnconstruction.com/home-renovation-contractors/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your home renovation contractors page lack alt text — descriptive labels that tell search engines

and screen readers what the image shows. This hurts both accessibility (people using sc

[P3] Title length 76 chars

https://bihnconstruction.com/contractor-for-kitchen-remodel/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Your kitchen remodel page has 5 images without alt text — descriptive labels that screen readers use to tell

blind visitors what an image shows, and that search engines use to understand your content.

[P3] Title length 87 chars

https://bihnconstruction.com/build-your-dream/
https://bihnconstruction.com/category/construction/
https://bihnconstruction.com/blog/
https://bihnconstruction.com/home-renovation-contractors/
https://bihnconstruction.com/contractor-for-kitchen-remodel/


https://bihnconstruction.com/kitchen-remodel-design-counter-top-pantry/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟡  MEDIUM

Five images on your kitchen remodel page don't have alt text—descriptive labels that explain what the image

shows. Search engines and screen readers (used by people with vision impairments) can't unde

[P3] Title length 89 chars

https://bihnconstruction.com/new-construction-home-inspection/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your new construction inspection page don't have alt text—a written description that screen

readers use to tell visually impaired visitors what the image shows, and that search engines

[P3] Title length 74 chars

https://bihnconstruction.com/split-level-kitchen-remodel/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Your website has 5 images on the kitchen remodel page that lack alt text — a text description of what each

image shows. Search engines can't read images directly; they rely on alt text to understand w

[P3] Title length 87 chars

https://bihnconstruction.com/flooring-contractor-insights/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your flooring contractor insights page don't have alt text—the hidden descriptions search

engines and screen readers use to understand images. This means visitors using screen readers c

[P3] Title length 96 chars

https://bihnconstruction.com/pool-contractors/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your pool contractors page don't have alt text—descriptive labels that explain what each image

shows. Search engines and assistive technology (used by people with vision impairments) ca

[P3] Title length 74 chars

https://bihnconstruction.com/kitchen-remodel-design-counter-top-pantry/
https://bihnconstruction.com/new-construction-home-inspection/
https://bihnconstruction.com/split-level-kitchen-remodel/
https://bihnconstruction.com/flooring-contractor-insights/
https://bihnconstruction.com/pool-contractors/


https://bihnconstruction.com/basement-renovation-cost/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your basement renovation cost page don't have alt text—descriptive labels that explain what

each image shows. Search engines and screen readers (used by people with vision impairments)

[P3] Title length 77 chars

https://bihnconstruction.com/whole-home-remodel/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your whole-home remodel page lack alt text — short descriptive text that screen readers read

aloud to visually impaired visitors, and that search engines use to understand image content

[P3] Title length 73 chars

https://bihnconstruction.com/excavation-contractors/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your excavation contractors page lack alt text — descriptive text that appears if an image fails to

load and is read aloud by screen readers used by people with vision loss. Search engi

[P3] Title length 86 chars

https://bihnconstruction.com/outdoor-home-renovations/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your outdoor renovations page lack alt text—descriptive labels that tell search engines and

people using screen readers what's in those images. Without alt text, those images are invisi

[P3] Title length 78 chars

https://bihnconstruction.com/fireplace-renovation/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your fireplace renovation page lack alt text—a short description that appears if an image fails to

load and helps screen readers describe images to visually impaired visitors. This hurt

[P3] Title length 88 chars

https://bihnconstruction.com/basement-renovation-cost/
https://bihnconstruction.com/whole-home-remodel/
https://bihnconstruction.com/excavation-contractors/
https://bihnconstruction.com/outdoor-home-renovations/
https://bihnconstruction.com/fireplace-renovation/


https://bihnconstruction.com/custom-home-builder/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟡  MEDIUM

Five images on your custom home builder page are missing alt text — descriptive text that screen readers read

aloud and search engines use to understand what each image shows. This makes your site har

[P3] Title length 87 chars

https://bihnconstruction.com/luxury-home-construction/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Your luxury home construction page has 5 images without alt text — descriptions that tell screen readers and

search engines what the images show. This blocks visually impaired users from understanding

[P3] Title length 87 chars

https://bihnconstruction.com/design-build-contractors/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your Design-Build Contractors page don't have alt text — short descriptions that explain what

each image shows. Search engines and assistive technology (screen readers used by people wi

[P3] Title length 83 chars

https://bihnconstruction.com/high-end-renovation/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your renovation showcase page lack alt text—descriptive labels that screen readers read aloud

to blind visitors, and that search engines use to understand image content. This means some

[P3] Title length 72 chars

https://bihnconstruction.com/major-home-remodel/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your major home remodel page lack alt text — a short description that tells search engines and

screen readers what the image shows. This hurts both accessibility (people using screen re

[P3] Title length 74 chars

https://bihnconstruction.com/custom-home-builder/
https://bihnconstruction.com/luxury-home-construction/
https://bihnconstruction.com/design-build-contractors/
https://bihnconstruction.com/high-end-renovation/
https://bihnconstruction.com/major-home-remodel/


https://bihnconstruction.com/the-essential-builders-guide-for-new-lot-

owners/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your blog post about lot owners are missing alt text — a brief description that appears if the

image doesn't load and that search engines use to understand what the image shows. This hu

[P3] Title length 84 chars

https://bihnconstruction.com/custom-home-construction-at-lake-keowee-

build-your-dream-lake-house/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your Lake Keowee custom home page lack alt text—descriptive labels that tell search engines

and screen readers what each image shows. Without alt text, people using screen readers can't

[P3] Title length 88 chars

https://bihnconstruction.com/the-cliffs-custom-home-construction/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Your project gallery page has 5 images without descriptive alt text. Alt text is hidden text that describes what an

image shows — it helps people using screen readers understand your photos, and it te

[P3] Title length 78 chars

https://bihnconstruction.com/modern-custom-homes-upstate-sc-

innovative-elegant-designs/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your Modern Custom Homes page lack alt text — short text descriptions that screen readers

(used by visually impaired visitors) read aloud, and that search engines use to understand what

[P3] Title length 81 chars

https://bihnconstruction.com/kitchen-renovation-greenville-sc-what-local-

experts-wont-tell-you-about-costs/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

https://bihnconstruction.com/the-essential-builders-guide-for-new-lot-owners/
https://bihnconstruction.com/the-essential-builders-guide-for-new-lot-owners/
https://bihnconstruction.com/custom-home-construction-at-lake-keowee-build-your-dream-lake-house/
https://bihnconstruction.com/custom-home-construction-at-lake-keowee-build-your-dream-lake-house/
https://bihnconstruction.com/the-cliffs-custom-home-construction/
https://bihnconstruction.com/modern-custom-homes-upstate-sc-innovative-elegant-designs/
https://bihnconstruction.com/modern-custom-homes-upstate-sc-innovative-elegant-designs/
https://bihnconstruction.com/kitchen-renovation-greenville-sc-what-local-experts-wont-tell-you-about-costs/
https://bihnconstruction.com/kitchen-renovation-greenville-sc-what-local-experts-wont-tell-you-about-costs/


Five images on your kitchen renovation article page lack alt text—descriptive labels that help both visually

impaired visitors and search engines understand what's in each image. Alt text is a basic a

[P3] Title length 99 chars

https://bihnconstruction.com/careers/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

All 5 images on your Careers page lack alt text—a text description that displays if an image fails to load and is

read aloud by screen readers for visitors with visual impairments. Without it, search

[P3] Missing OpenGraph metadata

https://bihnconstruction.com/our-process/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your "Our Process" page are missing alt text—descriptive labels that explain what each image

shows. Search engines and assistive technology (like screen readers for people with vision l

[P3] Missing OpenGraph metadata

https://bihnconstruction.com/portfolio/

_2 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your Portfolio page lack alt text—a short description that screen readers use to tell visually

impaired visitors what an image shows, and that search engines use to understand your cont

[P3] Missing OpenGraph metadata

https://bihnconstruction.com/custom-residential/

_2 findings on this page_

[P2] 5 image(s) missing alt text

[P3] Missing OpenGraph metadata

https://bihnconstruction.com/bathroom-renovation-cost/

_1 finding on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your bathroom renovation cost page are missing alt text — descriptive labels that screen readers

use to describe images to visually impaired users, and that search engines use to unders

https://bihnconstruction.com/careers/
https://bihnconstruction.com/our-process/
https://bihnconstruction.com/portfolio/
https://bihnconstruction.com/custom-residential/
https://bihnconstruction.com/bathroom-renovation-cost/


https://bihnconstruction.com/high-end-home-builder-in-south-carolina/

_1 finding on this page_

[P2] 5 image(s) missing alt text

https://bihnconstruction.com/home-builder-greenville-sc/

_1 finding on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your Greenville home builder page don't have alt text—a short description that screen readers

read aloud and search engines use to understand the image. This means visually impaired vis

https://bihnconstruction.com/services/

_1 finding on this page_

[P2] 11 image(s) missing alt text 🟠  HIGH

Your services page has 11 images without alt text — short descriptions that explain what each image shows.

Search engines and screen readers (used by people with vision loss) can't understand unlabele

https://bihnconstruction.com/services/design-build-services/

_1 finding on this page_

[P2] 5 image(s) missing alt text

https://bihnconstruction.com/services/commercial-construction/

_1 finding on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your Commercial Construction services page don't have alt text — descriptive text that explains

what's in each image. Search engines and screen readers (used by people with visual impai

https://bihnconstruction.com/services/custom-home-construction/

_1 finding on this page_

[P2] 5 image(s) missing alt text

https://bihnconstruction.com/services/project-management/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Project Management services page have no alt text—descriptive text that appears when

images fail to load and helps screen readers describe images to visually impaired visitors. This

https://bihnconstruction.com/high-end-home-builder-in-south-carolina/
https://bihnconstruction.com/home-builder-greenville-sc/
https://bihnconstruction.com/services/
https://bihnconstruction.com/services/design-build-services/
https://bihnconstruction.com/services/commercial-construction/
https://bihnconstruction.com/services/custom-home-construction/
https://bihnconstruction.com/services/project-management/


https://bihnconstruction.com/services/home-renovations-and-remodels/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your home renovations page don't have alt text — descriptive labels that explain what each image

shows. This makes those images invisible to screen readers (tools people with vision disa

https://bihnconstruction.com/services/additions-and-expansions/

_1 finding on this page_

[P2] 6 image(s) missing alt text

https://bihnconstruction.com/waste-water-treatment/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟡  MEDIUM

Six images on your waste-water treatment page don't have alt text — descriptive labels that tell search engines

and screen readers what each image shows. This breaks accessibility for people using scr

https://bihnconstruction.com/hospitality/

_1 finding on this page_

[P2] 6 image(s) missing alt text

https://bihnconstruction.com/government-civic/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

All 6 images on your Government & Civic Services page are missing alt text—descriptive labels that screen

readers use to describe images to visually impaired visitors, and that search engines use to u

https://bihnconstruction.com/k-12-education/

_1 finding on this page_

[P2] 6 image(s) missing alt text

https://bihnconstruction.com/multi-family/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your multi-family project page have no alt text — descriptive text that appears if an image fails to

load and that screen readers use to describe images to vision-impaired visitors. With

https://bihnconstruction.com/services/home-renovations-and-remodels/
https://bihnconstruction.com/services/additions-and-expansions/
https://bihnconstruction.com/waste-water-treatment/
https://bihnconstruction.com/hospitality/
https://bihnconstruction.com/government-civic/
https://bihnconstruction.com/k-12-education/
https://bihnconstruction.com/multi-family/


https://bihnconstruction.com/higher-education/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Higher Education project page lack alt text — descriptive labels that screen readers read

aloud to blind users and that search engines use to understand image content. This blocks b

https://bihnconstruction.com/office-interiors/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

All 6 images on your Office Interiors page lack alt text — the short descriptions that help both screen-reader

users and search engines understand what each image shows. Without alt text, visually imp

https://bihnconstruction.com/parks-recreation/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Parks & Recreation project page don't have alt text—descriptive labels that explain what's in

each image. Search engines can't read images, so without these labels, Google can't und

https://bihnconstruction.com/arts-entertainment/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Arts & Entertainment project page lack alternative text (alt text) — a short description that

appears when an image doesn't load and helps screen readers describe images to visually

https://bihnconstruction.com/faith-based/

_1 finding on this page_

[P2] 6 image(s) missing alt text

https://bihnconstruction.com/fire-stations/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

All 6 images on your fire stations page are missing alt text—short text descriptions that describe what each

image shows. Screen readers (used by people with vision loss) can't tell visitors what thes

https://bihnconstruction.com/clubhouses-community-amenities/

https://bihnconstruction.com/higher-education/
https://bihnconstruction.com/office-interiors/
https://bihnconstruction.com/parks-recreation/
https://bihnconstruction.com/arts-entertainment/
https://bihnconstruction.com/faith-based/
https://bihnconstruction.com/fire-stations/
https://bihnconstruction.com/clubhouses-community-amenities/


_1 finding on this page_

[P2] 6 image(s) missing alt text

https://bihnconstruction.com/wastewater-water-treatment/

_1 finding on this page_

[P2] 6 image(s) missing alt text

https://bihnconstruction.com/stream-ecosystem-restoration/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Every image on your website is missing alternative text (alt text) — a brief description that appears if the image

doesn't load and that screen readers use to describe images to visually impaired visi

https://bihnconstruction.com/pump-stations/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your pump stations page have no alt text—descriptive captions that tell search engines and

visitors using screen readers what those images show. Without alt text, those images are invisi

https://bihnconstruction.com/reservoirs-dams/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Reservoirs & Dams page have no alt text—short descriptions that tell screen readers and

search engines what the image shows. This blocks people using screen readers from understandi

https://bihnconstruction.com/utility-infrastructure/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Utility Infrastructure page lack alt text — descriptive text that explains what each image

shows. Search engines and screen readers (used by people with vision loss) can't understan

https://bihnconstruction.com/site-development/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Site Development page lack alt text — descriptive labels that screen readers use to explain

images to visually impaired visitors, and that search engines use to understand image con

https://bihnconstruction.com/wastewater-water-treatment/
https://bihnconstruction.com/stream-ecosystem-restoration/
https://bihnconstruction.com/pump-stations/
https://bihnconstruction.com/reservoirs-dams/
https://bihnconstruction.com/utility-infrastructure/
https://bihnconstruction.com/site-development/


https://bihnconstruction.com/parks-trails/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on the Parks & Trails page lack alt text—descriptive text that screen readers use to describe images

to visually impaired visitors, and that search engines use to understand what the image

https://bihnconstruction.com/pedestrian-bridges/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your pedestrian bridges page lack alt text—a short text description that appears if an image fails

to load and that screen readers use to describe images to blind/low-vision visitors. Se

https://bihnconstruction.com/custom-homes/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Custom Homes page don't have alt text — descriptive text that explains what each image

shows. This matters for two reasons: people using screen readers (accessibility software that

https://bihnconstruction.com/additions-renovations/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟡  MEDIUM

Six images on your Additions & Renovations page don't have descriptive alt text. Alt text is the hidden text that

describes an image; it helps people using screen readers understand what's shown, and

https://bihnconstruction.com/lake-mountain-properties/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Images on your Lake Mountain Properties page are missing alt text—a short text description that screen readers

use to tell visually-impaired visitors what an image shows, and that search engines use t

https://bihnconstruction.com/specialty-features/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Six images on your Specialty Features page are missing alt text — descriptive text that explains what each

image shows. This text is read aloud by screen readers used by visually impaired visitors, an

https://bihnconstruction.com/parks-trails/
https://bihnconstruction.com/pedestrian-bridges/
https://bihnconstruction.com/custom-homes/
https://bihnconstruction.com/additions-renovations/
https://bihnconstruction.com/lake-mountain-properties/
https://bihnconstruction.com/specialty-features/


https://bihnconstruction.com/parking-structures/

_1 finding on this page_

[P2] 6 image(s) missing alt text 🟠  HIGH

Your parking structures page has 6 images that lack alt text — descriptive labels that screen readers use to tell

visually impaired visitors what each image shows. This also means search engines can't

https://bihnconstruction.com/contact-us/

_1 finding on this page_

[P2] 7 image(s) missing alt text 🟠  HIGH

Every image on your Contact Us page is missing alt text — descriptive text that screen readers announce to

visitors with visual impairments, and that search engines use to understand what an image sho

https://bihnconstruction.com/commercial/

_1 finding on this page_

[P2] 17 image(s) missing alt text 🟠  HIGH

All 17 images on your Commercial page are missing alt text — descriptive labels that screen readers use to tell

blind/low-vision visitors what an image shows. Search engines also read alt text to unde

https://bihnconstruction.com/heavy-civil/

_1 finding on this page_

[P2] 22 image(s) missing alt text

https://bihnconstruction.com/wp-login.php

_1 finding on this page_

[P0] Sensitive artifact exposed: /wp-login.php 🔴  DO FIRST

Your WordPress admin login page (/wp-login.php) is publicly accessible and returns a success response. This is

a standard WordPress file, but leaving it exposed makes your site an easy target for auto
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